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EXERCISES

1.1 GETTING STARTED

1.2 INSTALLING BILLINGS

1.2.1 Billings in the cloud

Open the application from within InEight Platform. Platform’s primary function is to let you connect
and share data between all InEight applications involved in managing a project. This allows project
management workflows to pass between jobsite, field office, and front office seamlessly in a consistent

and standardized user interface.

Billings in the Cloud

1. Select a project, and then select Billings from the Main menu.
If you are using the legacy Billings application, click the installer download link distributed to you
via email by your local administrator.

Open InEight.Billings.Launcher?

https://billings-demo.hds.ineight.com wants to open this application.

Always allow billings-demo.hds.ineight.com to open links of this type in the associated app

_ Design
Quantity forecasting X
Open InEight.Billings.Launcher ncel
Engineering

| Billings

\ Launch InEight Billings

The Billings Launcher must be installed to run InEight Billings. If it is your first
launch, or you need the latest version ef the Billings Launcher select the
download button below.

Workspaces

Project library
This dialog will close in 28 seconds

2. If you are using Billings for the first time, select Download, and then select Next (or Open) to
start the one-time Billings Launcher download.
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Billings Launcher

Downloading...

About 3 minute(s) remaining

- Cancel
240104 .1

“H InEight Billings Launcher Setup

Welcome to the InEight Billings Launcher
Installer Wizard

Let's get started on installing InEight Billings Launcher on
your computer, Click "Next™ to continue or "Cancel” to exit.

Back | Miext Cancel

3. If prompted, complete the log in to the applications through your company’s log in portal

4. The InEight Billings launch page opens, and you can begin using Billings in the cloud.
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InEight Billings
DEMO (PTR2) [

b

ES
L
(=]
]

[OMCAR: Sl e

20240311223 PM  Status: Ready mt2dmoscussg\DTC2-MT2-DMO-SCUS-DB-8Bilings(B) 2432406501 .

1.2.2 Billings Legacy

The Billings application is launched by double-clicking the application icon placed on your system
desktop by the installer, after completing the application download via the URL provided to you by
your administrator. After the application is launched, the login dialog box may open if you have access
to multiple companies, otherwise the application will start.

If this is the first time you are running Billings, you will be prompted to complete the log in
process using your company’s log in portal.

Account:
nEight
(5) BILLINGS Password:
Company: | Bilings Internal . W
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Verify that the company you are logging into is correct, and then select OK.

When a new version of Billings is available, by your system administrator, you will get a message when
you attempt to log into the system. Click Download to update the version. You will not be able to
access Billings without installing the updated version.

1.2.3 Updating Billings

When a new version of Billings is available, the system will display a message indicating that an update
is available when you attempt to run the application. Click the Download link on the prompt to launch
your browser, and then click Launch Billings to update the version. You will not be able to access
Billings without installing the updated version.

1.3 BILLINGS CONFIGURATION

1.3.1 Application Configuration

The Billings application is configured to meet your specific business requirements, which is typically
accomplished when Billings is initially configured by the implementation specialist. However, multiple
options still exist for the system administrator to adjust the application as business needs change over
time.

Configuration and system maintenance include any of the following functions:
* Drop-down value lists

e Custom field definitions

e System integration schedules

e Billings mobile application rendering configuration

The term maintaining in this context means adding new values, editing existing values, or
removing no longer needed values.

1.3.2 Utilizing the System Configuration

Go to Suite Administration > System Configuration.

Page 12 of 154 InEight Inc. | Release 25.9



Billings User Guide 1.3 Billings Configuration

Only System Administrators will have access to configure the application.

Report Management

T,H' System Configuration

'I‘ Master Data Uploads

The System Configuration page opens as a new tab with the Field Setup sub-tab selected. This Field
Setup tab lets the Administrator create custom fields for any entity which contains a Details tab.
Custom fields are primarily created for master data-related entities, found in the Data Library menu,
but can also be used for the Projects and Timesheets.

To add a new custom field, click the Add Row ribbon bar button. The following entities support custom
fields:

e Cost Code — Global

e Personnel

* Cost Code — Project Specific
® Project and WBS items

e Personnel Classification

* Material

e Equipment

e Material Classification

e Equipment Classification

e Region
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e Division
e Time Sheet
e Company

Using the drop-down list, you can select which of the Billings entities to add a custom field to and then
type in the name for the new custom field in the Name column.

You can click the drop-down list for the Type column and then select how you want the data displayed
(such as, Date, Text, MRU Text, Personnel, Yes/No, Integer, or Decimal).

For certain entities, such as Project, you can also configure the “Scope”, that is, whether the custom
field applies to the entire project entity, to the Project only, or to the WBS items contained within the

project.

To delete any of the custom fields, you can highlight the item and click the Delete Row(s) button from
the home ribbon menu.

When complete, you can click the Apply button, or to exit the dialog box, you can either click the OK
button along the bottom right-hand side to save your changes and exit or click Cancel to exit without

saving changes.

1.4 SUITE ADMINISTRATION

1.4.0.1 User Management

To access user information from the Main menu, click Suite Administration > User Management. Only
an Administrator can access the Suite Administration or the User Management functionality.
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InEight Billings

Eﬂ Lser Management

The User Management tab opens listing all users in the system.

InEight Billings

= o X
HOME DEMO (PTR2) [0
@
= = C 2%  xuw & X
B Paste
Add Row Delete Refresh  Undo Layout Close
Row(s)

User Management ©

oﬂ The security manager allows you to add, edit, and delete users. Double clicking on a user will allow you to set their password and edit their permissions.

User Name Name

Status
"0 Qe s

Active

Active

Active

Active

Active

Active

oﬁ User Management Active
= Active
{4 Layout Management Active
Active

Iy — petve
Active

Tl System Corfiguration Active

T Master Data Uploads

2024-03-14 11:55AM  Status: Ready mt2dmoscussql\DTC2-MT2-DMO-SCUS-DB-18Billings(B)  24.3.24065.01  .:

When new users are added through Platform, they are automatically created in Billings as a standard
user, provided the appropriate suite and application access is granted through the InEight suite Roles
and Permissions. User authentication is performed through the customer’s Active Directory or Google
security validation, including any MFA requirements, therefore no Billings-specific password is
required. Once a user exists in the system, the Administrator can enlist the user in Billings user types
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and groups, as well as grant the user access to one or more regions. You can open a user record to

define its settings by double clicking on the user from the list.

@) User

General Permissions System Processes Mobile Project Security

® User Name:

Name:
E-mail:

Status: Active

Confirm Passwaord:

Enforce password policy

Enforce password expiration

User must change password at next login

Created:
Modified:

You must have a status of Active, be a member of at least one security role, and have
access to at least one Region before the system will allow you to complete the login pro-

cess.

1.4.0.2 Permissions Tab

As an administrator of the system, you control the type of functional access the user will have and can

restrict access to data by region utilizing the Permissions tab. Roles allow you to control which

functions of the system the user will be able to utilize. More than one Role can be associated with a
user. Regions allow the Administrator to control which data in the system the user will be able to see

or operate on, as constrained by the Role membership defined above.
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General Pemissions System Processes Mobile Project Security

User permissions are determined by both the roles assigned to them and the regions where those roles are effective.

Rales
Remove existing user roles or add user roles from the available roles list.
User Roles: Available Roles:
.
Certffication Power User
Certfication User
<< Add Certfication User (Read Only)
Remove =3 Expanded Process Editing
Expanded Project Editing
Expanded Timesheet Editing
Imports User il
Regions
@ Remove existing user regions or add user regions from the available regions list.
User Regions: Available Regions:

<< Add

0K Cancel :
1.4.0.3 System Processes Tab

On the System Processes tab, you can control the types of imports, exports, and adjustments the user
can execute. To grant access to any process, check it off using the check box located next to the
process description.
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General Permissions System Processes Mobile Project Security

Granting system process to user will allow userto perform Export, Import, or

Adjustment.
Processes
Type Description
Bilings Inter . Audit Trail Maintenance -

Adjustmerts | Actuals Task Transfer Adjustment
Adjustmerts | Retro Rate Adjustment

Imports Classffication Import

Imports Equipment Import

Imports HardDollar Project Import

Imports LEM Import

Imports Material Import

Imports Personnel Import

Imports Project Import

Imports Rate Table Import

Imports Timesheet Import

Imports Action Group Integration Import
Imports Action Integration Import

Imports Application Integration Import
Imports Control CBS Integration Import
Imports Control Payltems Integration Impaort
Impaorts Craft Integration Import

Impaorts Employee Integration Import
Impaorts Equ Category Integration Import
Impaorts Equipment Integration Import
Imparts Equipment Type Integration Import
Imparts Extemal Code Value Integration Import

TR P T N WY R,

Select the OK or Apply button to save any changes. This will return you to the main User Management
tab.

1.4.0.4 Regions

Regions are used to manage what users can see within Billings. If a user has permission to a Region,
they can see all resources, rate tables, projects, time sheets, LEMs, and Invoices associated to the
Regions they have permission for.

1.5 BILLINGS ADMINISTRATION

1.5.1 User Account Management Information

There are thirteen user roles or groups in Billings and five specialized roles for more security control. A
single application user can be a member of one or more roles, which determines the functional areas
of the application that they have access to. The following defines the thirteen groups:
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User Role Definition

Administrator The user designated as the technical application lead within the
system. This role manages the application security and users
interaction with the system through user groups. Members of this
group can perform all functions on all pages.

Power User User designated as the highest privileged user for their own region.
This role manages the setup of Billings and how it will affect reporting,
payroll, and integrations, and ensures the application is aligned to
client requirements.

Report Administrator User who has a deep understanding of Billings as well as the technical
knowledge to build reports using the Billings report manager. This role
can be used as a standalone for someone who only needs to access
the report manager to build reports or can be used in addition to any
other role that needs access to the report manager.

LEM A user who can approve LEMs. This role is unable to create, edit, or
Approver/Reviewer delete LEMSs, but they can complete all functions (except crediting an
invoice) that take place after a LEM is created

User User designated as having a higher skill set with capabilities to set up
information in Billings as needed.

Time sheet Entry User designated as having limited involvement in setting up
information in Billings.

User (No Rates) User level access to Billings except for access to rates information on
rate tables, time sheets, and reports.

Supervisor (View User designated to have view only and report generating rights in the
Only) application.
Imports User User who is monitoring or performing imports into Billings. This role

can be used standalone for someone who only needs to access these
functions or can be used in addition to any other role that needs access
to perform imports.

Certification Power User who manages the overall tracking of certification information,

User such as someone in HR or a corporate safety officer. This role can be
used standalone for someone who only needs to access the
certification module or can be used in addition to any other role that
needs access to the certification module.
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User Role Definition

Certification User User who only requires access to the certification information but is not

(Read Only) authorized to make changes, such as a Project Manager or
Supervisor. This role can be used stand alone for someone who only
needs to access the certification module, or can be used in addition to
any other role that needs access to the certification module.

Project Accountant User who manages running data exports and adjusting exported data.

Specialized User Role Specialized User Role Definition

Share Layouts Gives a user the ability to share their
personalized layouts with other users. The
members of this role cannot administrate
layouts for others, only their own.

Expanded Time sheet Editing Gives a user the ability to edit or delete export
batches (including LEMs and Invoices) created
by other users, if the user has the right to
create one or more Export batches
themselves. This means they will be able to
edit/delete batch results created by other users
for types that they have access to already.
Note that this functionality is already available
to all Power Users and Administrators. This
specialized security role simply gives the ability
to edit or delete export results batches created
by other users, and removes Approval Status
restrictions, elevating these rights to be
equivalent to the Power User role (but NOT the
Administrator role).

Expanded Export Editing Gives a user the ability to edit or delete
timsheets created by other users. This means
they will be able to edit/delete timesheets
created by other users . Note that this
functionality is already available to all Power
Users and Administrators. This specialized
security role simply gives the ability to edit or
delete timesheets by other users, and removes
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Specialized User Role Specialized User Role Definition

Approval Status restrictions, elevating these
rights to be equivalent to the Power User role
(but NOT the Administrator role).

Restricted Export Editing Gives a user the ability to edit or delete export
batches created by other users, if the user has
the right to create one or more Export batches
themselves (that is, they will be able to
edit/delete batch results created by other users
for types that they have access to already).
Unlike the Expanded Export Editing above, this
role does NOT allow users any added rights
over the Approval Status.

Mobile User (for use with the standalone User cannot use the desktop system, but can
client only) capture personal time sheets using the mobile
client

Mobile Foreman (for use with the standalone User cannot use the desktop system but can

client only) capture attendance and time sheets for
themselves and their crews using the mobile
client. This only applies to stand-alone mobile
customers.

1.6 HELP MENU

1.7 HELP OPTIONS

1.7.1 Contact Billings Support

If Billings Support is needed, click the Help icon and select Contact InEight Billings Support.
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[ Contact InEight Billings Support

@ System Info

C Refresh Menu

A blank e-mail to support@ineight.com will be opened using the default email application installed on
the desktop. You can enter in a full description of the issue including the following details:

e What user is having the issue
» Screenshots of the error and the window it is occurring in

¢ The time sheet #, LEM# and/or the Invoice #

e If it’s an error with a report, what report it is, and what parameters were used when requesting the
report.

e User contact information (e.g., Phone number, e-mail address)

Unitithed - Message (HTML)
Message Insert Options Format Text Review Help @ Tell me what you want to do
_—

i ] Arial

1.7.2 Verifying Billings Version Info

To find the application version information for Billings, got to Help > System Info.

The following window appears providing details on the version and the Billings website link.
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Aot el aght Ballngs O

Click OK at the bottom of this window to exit.

1.7.3 Refresh Cache

The Refresh Cache function allows the users to trigger a complete refresh of the locally cached
reference data. This includes, named resources, list of vendors and suppliers, classifications (trade and

craft) and category and type equivalent in Platform.

1.8 NAVIGATION

1.9 BILLINGS NAVIGATION

1.9.1 Navigation Menu

When opening Billings, the navigation list is collapsed. To view the menu items for navigating through

Billings, there are 2 options:

Option 1: Expand the menu by clicking the double arrow at the top left corner of the Billings window,
as shown in the image below. This will expand the menu to provide the name for each menu grouping;
you can then click the down arrow to open the list of items within each grouping (alternatively, click

the up arrow to collapse the grouping list).
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InEight Billings (Billings Internal)

Personnel

Equipment
InEight Billings (Billings Internal)

InEight Billings (Billings Internal) = Material

HOME

v

Personnel

Equipment
Material
mpanies
EI Cost Codes
@ Regions
[Eﬂ Divisions
@ Locations

= | Certifications

" %
£ o
[
3
I
& :
_
-

@&l
&

n

{@o
n
@o

Certification Types

(D)
O

Option 2: With your mouse, hover over the icon to see the grouping name, then click the desired
icon to provide you with the list of the items within that grouping.
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InEight Billings (Billings Internal)

HOME

=)

R |

Project Administration

e =T 29

[y

n
oo

OND

1.9.2 OK, Apply, and Cancel Buttons

You will notice the OK, Apply, and Cancel buttons are available on most of the Billings data
maintenance pages. Pressing Cancel exits the page and discards any changes that you have made. The
functionality of the OK and Apply buttons differs slightly depending on whether you are creating a new
record or modifying an existing record. In both cases, pressing either of the buttons saves your changes
to the database. However, if you are adding a new record, pressing Apply not only saves the data to
the database, but also refreshes the page to let you enter yet another record. Clicking OK saves the
data but then exits the page. This is to maximize the data entry speed by allowing you to add multiple
new records without needing to exit the page.

List / Grid Modification

If there are columns that you do not require, you can remove them with the following steps:
1. Select the column header by clicking and holding the mouse button down.
2. Drag it downwards until you see an “X” appear.

3. Drop it by releasing the mouse button and the column will be removed.
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4. Repeat this step for all the columns you would like removed.

Perform the following steps If you would like to retrieve a removed column or any other columns
which may not be visible by default.

1. Right click anywhere on the column header row to bring up a pop-up menu.
2. Select Column Chooser. A Customization window opens.
3. Click and hold the mouse button on the field you require.

4. Drag and drop the field to the column position where you would like it to appear on the grid.

You have to drop it in the header section of the page.

1.10 FILTER FUNCTIONALITY

When opening a page within Billings which contains a grid, an auto-filter feature is available. This
feature is available with pages containing the following data:

e Timesheet
e LEM

* Invoice

e Project

e Rate Table
e Company
e Cost Code
e Equipment
e Personnel
® Region

* Division
Each of these pages includes a row directly under the column header row dedicated to filtering. In this

row, you can narrow the list by entering in specific criteria (e.g.., T/S Number, LEM number, Project
Name, etc.). A filter icon appears in each column header when the mouse is placed over the column. If
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a filter is activated, the icon is highlighted. If the filter icon is clicked, the filter can be automatically
adjusted by selecting from the options of Custom, Blanks, or Non-blanks.

Edit Filters

In the bottom right corner of the page, you can select the Edit Filter button to adjust the default filter
settings.

1. Select Edit Filter.

Edit Filter

2. Click the And button to select any of the following options:
e And

e Or

e Not And

e Not Or

Filter Editor b

¢ 8 8 8 3
s o

= Cancel AR

3. Click the Plus button beside the And button to select one of these options:
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¢ Add Condition

e Add Group
ard

Within this row, each character can be edited.

Another option when retrieving data is the Quick-Type feature. This lets a user open an existing list and
begin typing in the first characters of the word. Billings will automatically begin to filter the list by
these characters. The example below is searching LEM Numbers by the letter s. Billings will display all
LEMs beginning with this character.

1.11 UTILIZING LAYOUT MANAGEMENT

To access the Layout Manager from the Main menu, select Suite Administration > Layout
Management.

Only System Administrators will have access to configure the layouts for other users.
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28
2§ User Management
o= !

[T Lavout Management

REpart Management

The Layout Management page appears. The Layout Management tool is user specific. This means any
layouts listed in the window are layouts the logged-in user has previously created and saved through
the various page’s Layout ribbon bar functionality, or layouts that have been shared with this user.

From the General tab, you can view the available layouts and delete any layouts that are no longer
required. To delete a layout, highlight the line item by clicking on it, then click the Delete Row(s) icon
located on the ribbon menu.

Click the View tab to view the basic outline of the selected layout. Any changes made to the layout
from this preview will not be saved; this is strictly for viewing purposes. All changes must be done from
the page to which the layout applies.

If you are viewing a time sheet layout, you must be in the time sheet page to change the layout
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Click Apply or OK on the bottom right to exit the Layout Management window.

1.12 DATA LIBRARY
1.13 CLASSIFICATIONS

1.14 CREATE A NEW PERSONNEL
CLASSIFICATION

Billings will receive all operational resources associated to personnel, including Trade and Craft lists,
from InEight Platform. Both Trade and Craft will populate the Personnel Classification library. However,
it may be necessary or desirable to add additional classifications or organize the Trade and Craft items
received from Platform into a deeper structured format.

Create a new Personal Classification

1. Open the Data Library menu item and select Classifications > Personnel.
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Copy
H cut

Refresh ) . — Undo  Show Active
(B Paste Speda Only
P Regions Personnel Classification ©
Equipment |©  add | Remave | |Q,  Find

» | .KC_Carpenter 1 (KC-CP1)
» | KC_Carpenter 2 (KC-CPZ)
» | .KC_Carpenter 3 (KC-CP3)

Lo

Material

Personnel » | KC_Carpenter 4 (KC-CP4)

» | .KC_Labourer - Intermediate (KC-LEIN)
Equipment » | KC_Labourer - Junior (KC-LBIR)

» | .KC_Labourer - Senior (KC-LBSR)
Material » | KC_Superintendent (KC-SUP)

» | .KC_Welder - B Pressure (KC-WDBP)

2. The Personnel Classification tab appears. This tab lets users view all records and create new or edit
existing personnel classifications that were configured for billing purposes.

3. Right click the Personnel (Emp) icon and select Add Classification from the dialog box or click the
Add button located just above the list of classifications.
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gl Personnel {Emp]

4. On the General tab, enter the Description and Code. The Status field automatically defaults to Active
and the Parent field is grayed out and will automatically default to the appropriate parent node from
the classification tree.

5. You can create classification structures by dragging and dropping individual classifications into other
classifications, building up a tree or folder-like structure. This lets you group classifications.

6. Click the Details tab. This section is used to capture custom field values.

7. Click Apply or OK at the bottom of the page to save your changes.

1.15 CREATE A NEW EQUIPMENT
CLASSIFICATION

Billings will receive all operational resources associated to equipment including the Equipment
Category and Types lists from Platform. Both Category and Type will populate the Equipment
Classification library. However, it may be necessary or desirable to add additional classifications or
organize the Category and Type items received from Platform into a deeper structured format.
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Create a new Equipment classification

1. To create a new Equipment classification, open the Data Library menu and select Classifications >
Equipment.

2. The Equipment Classification tab appears. This tab lets you view all records or create new and edit
existing equipment classifications that were configured for billing purposes.

e

3. Right click the Equipment icon and choose Add Classification from the menu or click the Add button
located in the ribbon menu above.
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4. In the General tab, enter the Description and Code.
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5. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization's requirements.

6. Click Apply or OK at the bottom of the page to save your changes.

1.16 CREATE A NEW MATERIAL
CLASSIFICATION

Create a new Material Classification

1. Go to Data Library > Classifications and then Material.

Personnel

Equipment

: Material

Personnel

Equipment

Material

2. The Materials Classification tab appears. This tab lets you view and edit all material classifications
currently in the system.

3. Right click the Material and select Add Classification from the resulting menu or click the Add
button located in the page’s ribbon menu.
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4. In the General tab, enter the Description and Code.

5. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization requirements.

6 . Click Apply or OK at the bottom of the page to save your changes.

1.17 RESOURCES

1.18 CREATE NEW PERSONNEL RESOURCES

Billings will receive all operational resources associated to personnel from the Master Data Library
within Platform.

Create a new Personnel resource

1. To create an additional resource, that will be used for purposes of customer billing only, go to Data
Library > Resources > Personnel.
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3. The Personnel window opens. Enter the employee’s last and first name in the appropriate fields.

4. Assign a personnel code in the Code field.

The Code must be unique within the database. As a best practice use your organization’s
internal code for the individual.
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5. Click the drop-down arrow on the field labeled Source. This field lets you label the resource as a
subcontractor, employee, third party or any other description previously set up by the system

administrator.

6. Click the ellipsis (three dots) icon in the Billing Classification field. A Classification dialog box appears.
Select the Employee’s classification by double clicking on it.

You can use the Search feature at the top of the pop-up to search for the classification using
either the name or the code.
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7. The Cost Classification field will replicate the classification chosen in the Billing Classification field.
However, this can be changed if required by clicking on the ellipses icon in the Cost Classification field
and updating accordingly.

8. Click the ellipses icon in the Company field. This field lets users assign a worker to the company for
which they work for.

As an example, if the employee works directly for ABC Company, select ABC Company as the company
name. If the employee is a subcontractor working for Al’s Contracting Services, select Al’s Contracting
Services as the company the worker works for.

9. Scroll through the list or use the Search field and type in the name of the company the worker is
working for. Double click to select the appropriate company.

Stabs At EdtFite
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10. Click the ellipses icon on the Region field. A Region window appears. Scroll through the list or type
in the region name in the Search field. This associates the worker with a default region.

& Region

11. Click the drop-down arrow of the Payroll Status field and select if the person is On Payroll or Off
Payroll. The value selected here is used to determine if this person’s hours should be sent to the

payroll system.

Payvrol Stabs:

--_"- -
Staties: T AT

Shifft Rotabon:

12. Click the drop-down box on the Shift field. A selection of Day, Night, or Other shift appears. Select
the default shift type the employee typically works.

You can always indicate the actual shift worked when time is captured for this worker on a time
sheet. This often happens when a worker is temporarily working a different shift from what

their master personnel record is set to.
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1.19 Create a new Equipment Resource

13. Shift Rotation is not required but can be added if there is a need to include this information on
Billing reports. Click the drop-down box on the Shift Rotation field. A selection from the Options
window appears. Select the default Shift Rotation the employee typically works. Shift Rotations are
defined in the Options menu under Drop-Down List Setup > Shift Rotation Type.

14. Click the Details tab. This section is used to capture custom field values. Populate any custom fields

per your organization requirements.

1.19 CREATE A NEW EQUIPMENT RESOURCE

Billings will receive all Operational Resources associated to Equipment from the Master Data Library

within Platform.
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Create a new Equipment Resource

1. To create an additional resource that will be used for purposes of customer billing only, go to Data
Library > Resources and then Equipment.

= InEight Billings (Billisgs Internal)

e

2. The Equipment Resources tab appears. click the Add Row icon on the ribbon bar.

c, 5 B’ X

2 # # @ ¥ -

3.The equipment setup window opens. Enter in the name of the unit in the Name field.
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4. Enter in the unit number for the piece of equipment in the Unit # field and the unit code in the Code
field. While these can be the same, they do not need to be. The Unit # is typically matched to the
equipment placard, while the code is typically matched to that equipment’s accounting code
designation.

5. Click the drop-down arrow on the Source field. This field lets you label a piece of equipment as
belonging to an operator, owned, third party, subcontractor or any other custom description
previously set up by your system administrator.

6. Click the ellipses (three dots) icon in the Billing Classification field and the Cost Classification field. A
Classification window appears. Select the unit’s classification by double clicking on it.
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You can use the Search feature at the top of the pop-up to search for the classification using
either the name or the code.

7. The Cost Classification field will duplicate the classification chosen in the Billing Classification field.
However, this can be changed by clicking on the ellipses icon in the Cost Classification field and
changing it as required.

8. Click the Details tab. This page is used to capture custom field values. Populate any custom fields per
your organization’s requirements

1.20 CREATE NEW MATERIAL RESOURCE

Create a new material resource

1. To begin creating new material, go to Data Library > Resources > Material.
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1.20 Create new material resource

=  Intight Bilings (Bilings Internal)
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3. The Material window opens. Enter the material Name and Code.

B Material

Modified:
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4. Click the drop-down arrow on the field labeled Source. This field lets you label a piece of material
using one of the user-defined Material Types.

5. Click the ellipses (three dots) icon in the Billing Classification field and the Cost Classification field. A
Classification window appears. Select the material’s classification by double clicking on it.

You can use the Search feature at the top of the pop-up to search for the classification using
either the name or the code.
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6. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization’s requirements.

7. Select Apply or OK at the bottom of the page to save your changes.

1.21 CREATE A LOCATION

Locations are used to help in tracking of labor and equipment when they're not assigned to a project.

Create a location

1. To create a location, go to Data Library > Location.
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3. Enter the location description in the Name field and the location code in the Code field.
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4. Click Apply or OK at the bottom of the page to save your changes.

1.22 CREATE A NEW DIVISION

Create a new Division

1. To create a new division, go to Data Library > Division.
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3. The Division window appears. Fill in the Name and the Code fields. Both are mandatory.
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Divisions must be unique within the database.

(4 Division m| x

zeneral Detail

rm ;_ Mame:

Code:
Status: Active -

MNotes:

Created:
Modified:

K Cancel Apply

4. The Status field will automatically default to Active. Enter any notes pertinent to the division in the
Notes section.

5. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization's requirements.

6. Select Apply or OK, located at the bottom of the page to save changes.
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Clicking Apply saves the changes and opens a new setup window, allowing you to quickly
make another entry. Clicking OK will save the changes and close the setup window.

To view the Divisions tab and all divisions that have been set up, refer back to the steps above, where
you opened the Division tab.

Any ribbon menu, where there is a Send To function, lets you send the contents of the act-
ive tab to Excel.

The available columns on the Divisions tab are:
* Name
e Code

e Status

If there is a column header that is not currently in view when the page is open and you
would like to see it, right click any column header, and select Column Chooser.

1.23 CREATE NEW COMPANY (CLIENT OR
SUPPLIER)

Project related vendors are integrated from the Assigned Vendors in Platform. If additional companies
need to be added that have not been automatically created from the Assigned Vendors in Platform, a
new company (client, supplier or vendor) can be created with the following steps.

Create new Company (Client or Supplier)

1. Go to Data Library > Company.
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3. Enter the company name in the Name field. Enter the applicable code in the Code field. Click the
drop-down box in the Type of Relationship field. Select whether the company is a Client, Supplier or
other description previously specified by your system administrator.

InEight Inc. | Release 25.9 Page 53 of 154



1.23 Create new Company (Client or Supplier) Billings User Guide

M company: O X

e dddress Contact =gy Dbl

-]
o T
B

Ciode;

Tvpe of Relabonship: .

Sabes: 5~ =

ATV E

e b

Lrestecs

Modfied:

L, . Aoy
e i e S
Tk m -
L
] o
g PR

Page 54 of 154 InEight Inc. | Release 25.9



Billings User Guide

1.23 Create new Company (Client or Supplier)

4. The Status field will automatically default to Active. Enter any notes pertinent to the company in the
Notes section and then click the Address tab. Enter the necessary information for the primary address
as listed. You can use the arrow keys or Tab key on your keyboard to move between fields.
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5. Click the Details tab. This section is used to capture custom field values. Populate any custom fields
per your organization's requirements.

6. Click the Append icon at the bottom, left of the page to add another address. If you need to remove
an address card, select the one to be removed, then click the Delete icon.

7. Continue the same steps to enter details in the Contact, Phone and Details tabs. When ready, click
Apply or OK at the bottom of the page to save your changes.

1.24 PROJECT MANAGEMENT

1.25 RATE TABLES

1.26 CREATING A NEW RATE TABLE

A rate table consists of personnel, equipment, material, and line item rates for premiums and
allowances, as well as other rate exceptions. A rate table must be created and associated with a
project prior to any billable work being LEM'd or invoiced for that project. A single rate table can be
used by one or multiple projects and you can add a rate table to a specific project WBS item.

1. Go to Project Administration > Rate Tables.

,‘-‘f_ Sites

) Budgets

E Commitments

Rate Tables

=3

P

=]

2. The Rate Tables tab opens. You can select any rate table to modify, or you can create a new rate
table by clicking the Add Row icon on the ribbon bar.
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3. In the resulting new rate table tab, enter the name for the new rate table in the Name field. In the
Code field enter the new code. This can be a numeric value or an abbreviation that the rate table goes

by.

4. Select the appropriate region the rate table belongs to.

5. The Status field automatically defaults to Active. Enter any notes pertinent to the rate table in the
Notes section and then click Apply to create the rate table

1.26.0.1 Column Display Options

The Column Display Options button lets you show or hide columns by going to Rate Tables > Selecting
a rates table, and then selecting or deselecting each shift column from the Column Display Options
button from the ribbon menu. By default, at least one item needs to be selected. If all items are
deselected, the drop-down will default to show day shift for Personnel, or Type 1 for Equipment.
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1.26.0.2 Company and Source columns

The Company and Source columns give you flexibility when working with different companies, roles or
resource types. These columns are listed in the personnel, equipment, material, and line items tabs of
the rate table and allow you to set different rates based on what role is performing the work or where
the resource comes from. For example, if rates differ between companies for the same role, where a
subcontractor charges $30/ST hour, and an employee charges $25/ST hour for day shift, and $27/ST
hour for night shift, you can use the Company and Source columns in the rate table to define those
rates without having to create separate rate tables.

Rabe Tables Rate: Labor 12 &

Rates  Eguomert Rutes  Mster Rates | Lne hem Rl

Example Architect

1.26.0.3 Personnel Rates

In the same new rate table tab as above, click the Personnel Rates tab to start entering personnel rate
information.
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By default, the most current rates for each classification (and optionally, named resource) are shown.
To view the rates that were in effect on a different date, change the effective date in the Shown rates
effective as of drop-down above the rates grid.

To add a new personnel rate record, click the Add Row icon located in the ribbon bar. If you wish to
delete a record, select it by clicking it once, and then click the Delete Row(s) icon located in the ribbon
bar. Click the drop-down list or the ellipses (three dots) icon under the Classification column and select
the classification being assigned to the rate record.

0
1
=
=
L@
il 8

Code Classificaton Classrfhica bion Risgon Ctahs

&
%

Optionally, Billings supports rates for individual resources by classification. For example, John
Smith working as a skilled laborer can be billed out at rates different than the standard skilled
laborer rates. If you choose to enter a rate for an individual in the classification selected, click
the drop-down list under the Resource column, and then select the individual assigned to the
rate record.
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Select the Effective Date of the rate record (that is, when does this rate take effect) and enter in the
rates to be used for the different earnings class by shift (i.e., Straight Time, Overtime, Double Time,
Double Time and a Half, Travel Time, LOA, and Day). Repeat these steps to add another classification to
this rate table.

1.26.0.4 Equipment Rates

To start entering equipment rate information for the rate table you have open, click on the Equipment
Rates tab.

HOME DEMO (PTR2) [
(& Copy

= = C 77 x« [J g O m X
[§ Paste

Add Row Delete Refresh S Undo SendTo MassEdt Show Rate Layout Close

Row(s) > Code >
Rate Tables Rate: EX1 ©
General Personnel Rates Egquipment Rates Material Rates Line tem Rates

Edit your equipment rates here. By default, the most current rates for each cassification are shown.
To view the rates that were in effect on different dates, change the effective date.

Show rates effective as of: | Oct-31-2024

Classffication Resource Eff. Date Each Hours Days Weeks

o o
Spyder Crane (15-12) Aug-01-2023 - 100.00 1000.00 6000.00
Tank - 640 L Fuel (38-02 Aug-01-2023 50.00 300.00
Record 10f 2 « >

OK Cancel Apply

By default, the most current rates for each classification (and optionally, named resource) are shown.
To view the rates that were in effect on a different date, change the effective date in the Shown rates
effective as of drop-down above the rates grid.

To add a new equipment rate record, click the Add Row icon located in the ribbon bar. If you wish to
delete a record, select it by clicking it once, and then click the Delete Row(s) icon located in the ribbon
bar.

Click the drop-down list or the ellipses icon under the Classification column and select the classification
being assigned to the rate record.
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Optionally, Billings supports rates for individual resources by classification. For example, JD
Backhoe operating as an excavator can be billed out at rates different than the standard
backhoe rates. If you choose to enter a rate for an individual piece of equipment in the selected
classification, click the drop-down list under the Resource column, and then select the individual
piece of equipment assigned to the rate record.

Select the Effective Date of the rate record (that is, when does this rate take effect) and enter in the
rates to be used for the different earnings class by shift (i.e., Hours, Days, Weeks, Months and a
Standby and Each). Repeat these steps to add another classification to this rate table.

1.26.0.5 Material Rates

To start entering material rate information, click on the Material Rates tab under the Rate table tab

you are in.
HOME DEMO (PTR2) O
(& Copy T =
= = C " X cu [z O mE X
B Paste
Add Row Delete  Refresh 5 Undo SendTo  Mass Edit Show Rate Layout  Close
Row(s) - Code -
Rate Tables Rate: EX1 @
General Personnel Rates Eguipment Rates Material Rates Line ltem Rates
Edit your material rates here. By default, the most current rates for each classification are shown.
To view the rates that were in effect on different dates, change the effective date.
Show rates effective as of: | Oct-31-2024
Classffication Resource Eff. Date Each
/a4 Afc
= Oct-31-2024
Record 1 of 1

0K Cancel Apply

By default, the most current rates for each classification (and optionally, named resource) are shown.
To view the rates that were in effect on a different date, change the effective date in the Shown rates
effective as of drop-down above the rates grid.
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To add a new Material rate record, click the Add Row icon located in the ribbon bar. If you wish to
delete a record, elect it by clicking it once, and then click the Delete Row(s) icon located in the ribbon
bar. Click the drop-down list or the ellipses icon under the Classification column and select the
classification being assigned to the rate record.

Click the drop-down list or the ellipses icon under the Classification column and select the classification
being assigned to the rate record.

Optionally, Billings supports rates for individual items by classification. If you choose to enter a
rate for an individual material in the classification selected, click the drop-down list under the
Resource column, and then select the individual material being assigned to the rate record.

Select the Effective Date of the rate record (that is, when does this rate take effect) and enter in the
rates to be used for the earnings class (i.e., Each). Repeat these steps to add another classification to
this rate table.

1.26.0.6 Line Item Rates

To start entering Line Item rate information, click on the Line Item Rates tab under the Rate table tab
you are in. Continue adding the necessary resource type, classifications, and line item types for the
project and the corresponding rates.
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Edit your line item rates here. By default, the most current rates for each dassification are shown.
To view the rates that were in effect on different dates, change the effective date.

show rates effective as of:  Oct-31-2024

Resource Type Classification Assigned To Line kem Type Eff. Date Each
aflc Alc aflc aflc
= 2 Personnel Iron Worker - Joumeyman {IW-JM) Allowance - LOA Dec-01-2023 20000 ~
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B2 Personnel Iron Worker - Fareman {IW-FM} Mlowance - LOA 250.00
£ Personnel Premium - Corfined Space 1.50
£ Personnel Premium - Fire Watch 50
£ Personnel 25
g Personnel Allowance - Travel_Daily
2 Personnel Allowance - Travel _Shift Jan01-2024 500.00
Record 1of 8

0K Cancel Apply

By default, the most current rates for each classification (and optionally, named resource) are shown.
To view the rates that were in effect on a different date, change the effective date in the Shown rates
effective as of drop-down above the rates grid.

Edit your line items rates here.

To add a new Line Item (e.g. Premium or Allowance) rate record, click the Add Row icon located in the
ribbon bar. If you wish to delete a record, select it by clicking it once, and then click the Delete Row(s)
icon located in the ribbon bar.

Select the Resource Type in the first column (i.e., Personnel, Equipment, or Material) to indicate which
entity type the rate record will apply to.

Click the drop-down list or the ellipses icon under the Classification column and select the type being
assigned to the rate record. The list here will be determined by the Resource Type specified for the
row.

Optionally, Billings supports rates for individual resources by classification. If you choose to
enter a rate for an individual resource in the classification selected, click the drop-down list
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nder the Resource column, and then select the individual resource being assigned to the rate
ecord.

Select the Line Item Type in the next column (note that this list will be determined by your system
administrator during application configuration as it is configurable) to indicate which entity type the
rate record will apply to. Select the Effective Date of the rate record (that is, when does this rate take
effect) and enter in the rate to be used for the earnings class (i.e., Each). Repeat these steps to add
another row to this rate table.

1.27 COPYING A RATE TABLE

In some cases, you will need to create a new rate table that’s very similar to an existing one. Instead of
performing the entire process of creating a new rate table, the best process would be to copy a rate
table.

Copy a Rate Table

1. Go to Project Administration > Rate Tables.

2. The Rate Tables tab appears. Select the rate table to be copied by clicking on it once with the mouse,
then on the ribbon bar, click Copy .

oo = L .- [O& B X
—— -
ot o e e ]

Page 64 of 154 InEight Inc. | Release 25.9



Billings User Guide 1.27 Copying a Rate Table

3. Now click Paste or Paste Special to make a copy of the rate table.

Paste creates an exact copy of the source rate table, while Special Paste lets you control what and how
the rate table is copied, including adjusting effective dates, changing rate table name, and code, and
adjusting other aspects of the rate table that are applicable for the new rate table. If Paste Special is
selected, the Paste Special window will appear

4. Under section 1, change the name of the rate table and type in an appropriate Code for the new rate
table.

Paste Special (Copy of # [Internal] Shop/Yard Facility - COST) x

5. Under section 2, determine precisely what portion of the rate table you want to be copied (either
Personnel, Equipment, Material, Line Items, or all four sets of rates).

6. Section 3 gives the choice of copying the rates exactly as they exist in the original rate table or to
modify the effective dates. If the effective date requires modification, choose the date the rates will be
effective from.

7. Section 4 determines the next steps, either to return you to the rate table list or open the new rate
table.

8. After the modifications have been made, click OK along the bottom of the rate table screen to save.

If Open the new rate table is selected, the new rate table will open allowing you to make any
additional modifications.

10. After the modifications have been made, click OK at the bottom of the rate table page to save.
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1.28 MANUAL RATE IMPORTS

The Manual Rate Import wizard will guide you through importing labor, equipment, material or line
item rates from a spreadsheet.

To import multiple rate types, you must run the import wizard for each rate type

A custom template can be used to map and import data into the Billings rate tables. Template
spreadsheets are provided when accessing the wizard, but any Microsoft Excel spreadsheet can be
used and mapped through the wizard process. After the templates have been downloaded and ready
to import, click next to continue.

=
>
e C 7 xe = X
% S undo Citera Close:
=3
= mport ©
= .
Welcome to the Manual Rate Import wizard

d wil guide you through importing Labour, Equipment, Material, or Line [tem rates i port types of
(2]
I
2e

e e

Import rate table file and configure settings

1. In the Rate table File section, select a file by clicking the ellipses, select the file, and then click open.
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- & x
HOME 21 0O
B Co —_
B Copy % e X
5 Past -
Refesh S Undo Citsiia Clos
tarwsal Rate lmpot ©
Step 1: Data
Jectth e and corfigure setings
Rate Table e =

Rate Table Type: @ Single rate perrow of data Mutple rates per row of data
Ignore the frst rows(s) @y -

2. Columns from the imported file appear and can be updated in the Billings data selection screen.
After reviewing the imported data, click Next.

Manual Rate import  ©

Step 1: Data Selection
Select the rate table fle and configure settings

Rete Table Fle: | C:\Users InEightDeskiop 25.3 BillngsRate Table Import - Labour Template xisx
Rate Table Type: (@) Single rate per row of data Muitiple retes per row of data
Ignore the first rowsis) Resourcs Type: Labour
nett | A B c D £ F G H I i K L M N o
1 Straight Tme: Overtime Double Tir
2 Classfication Name Cassfication Code Classfication Type Classfication Peth Compary Name  Company Alas  Resowos Souce  ResowceCode  CustomerClass Code B Date  Day Shit Night Shift DayShit  Night Shitt Day Shit

3. The Column Mapping section lets you specify the column mappings. Fields with an asterisk are
required.

Click the matching line# drop-down (arrow/list) next to each resource to map the columns, and then
click Next.
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Step 2: Column Mapping
Specily the column mappings. Felds marked wth an astrisk (7) are required

Linest A B c D E F G H J K L M N (]

Match Classfication Name
e e Straight Time: Overtime Double Tin

1sssication -
Match Classfication Type .
Match Classfication Path -
Match Company Name
Match Company Alas
Match Resource Source
Match Personnel Code
Custom Code Column
Effective Date Column
* Shit Column
* UOM Type Column
* Rate Cokmn
Rate Code Column

<Back || Net> Cancel

4. Review and make any corrections in the Rate Table overview before you continue.

Only the records without errors are imported. To investigate errors, click the Log drop-down list. Click
the Back to fix any errors or Next to continue.

dg d column NEeader Nere 10 group oy that

Line # Emor Mag Log Classification Mame Clagsification Code

- [ —————. |1"| ............. Classification Code

CIassName Classification Mame
ClagsCode: Clagsfication Code

Class Type: Classiffication Type
EffectiveDate: Effective Date
ClassPath: Classification Path

Finding compary |0 for Company Alias
Company Alias’ and CompamyMName
Company Mame'

Rate table row key:
{"ClassID"rull,"Lab DefID" null,"Equ
DefID":null,"Mat DefID":null,"Lineftem

Tommm il Mlal ims B Fmlnn M e

QK Cancel

5. Select Create New Rate or Update Existing Rate Table to specify how to import the data, and then
click Next start your import.
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When creating a new rate table, label it in the Rate Table Name field. The Rate Table name, Rate Table
Code and Region fields are required to proceed.

Manual Rate Import © =

Import Rate Table
Please specify how to import the data. When you click "Next,” we will start the import.

#  Create New Rate Table I Update Existing Rate Table
Rate Table Name Rate Table Code
Default Effective Date | Apr-17-2025

Region

< Back Cancel

5. Click Next and then Finish to save your import.

1.29 IMPORTING A RATE TABLE

Billings lets you create and maintain rate tables externally in a spreadsheet format and import the
rates into an existing rate table or as a new rate table. There are two forms of rate table imports.

You can use the Rate Import template through Processes > Imports > Rate Table Import or the Legacy

Labor Rate Import as shown below.

Legacy Labor Rate Imports

Currently, Only Personnel rate import is supported
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1. To Start the import process, select Project Administration > Rate Tables and select Import Rates
from the ribbon bar.

(B Copy - = POy

= = C 8 Kot @ e
AddRow Delste Refresh = Unde & PrintPreview cendTo  [mport
Ruwels) ' Rates

2. The Rate Import wizard appears.

3. Select the spreadsheet file to import by using the ellipses (three dots) icon to launch the file picker
and select the path and the rate table Excel file.
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5. Specify whether the rates are stored horizontally or vertically in the spreadsheet and indicate how
many of the top rows to ignore (for example, header row which may contain column names). Click
Next to proceed.
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6. The second page of the wizard lets you map columns or rows in the spreadsheet to resource
classification, resource identifier (if required), and units of measure. The mappings are different
depending on whether the rates spreadsheet is horizontal, or vertical.

Single rates per row of data layout:

Multiple rates per row of data layout:
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7. After you have mapped the columns, click Next to go to the third page of the wizard which will
preview the imported rate table in Billings format.

8. The last column in the import preview page specifies errors that have been found with each line of
the import file. Only lines which are error-free will be imported into Billings. Review and correct any
errors reported and click Next to proceed.

9. The final page of the wizard lets you control whether the rate import will be imported into a new
rate table or whether the import will update an existing rate table.

10. Create a Rate Table Name or choose an existing rate table from the Rate Table Name drop down
list. If the Update Existing Rate Table option is selected. Indicate the Effective Date for the rates. After
you are done, click Import to import the rates.

1.30 UTILIZING MASS EDIT WITH A RATE
TABLE

The Mass Edit feature is available to users to simultaneously adjust multiple rates within a rate table.
This function frees you from needing to adjust each rate individually. Although this functionality is
beneficial, you must be cautious when applying it, as multiple rate records are affected simultaneously.
The mass edit feature can also be used to clean up a rate table after it has been updated using the Rate
Import Wizard (for example, to remove any new rates that did not actually change from prior effective
date).
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1.30 Utilizing Mass Edit with a Rate Table

mass edit Rate Tables

1. Go to Project Administration > Rate Tables.

3. The rate table opens in a new tab, with the General tab active below it.

Rate Tables Rate Table O

il Poer dorwss] Flabed Euspenant Rates Sy teral R e
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4.Review the Personnel, Equipment and Material Rates tabs to confirm your selection is correct for
making mass edits. From the ribbon bar, select Mass Edit.

[t Mass pdt Rates

5. In section 1, select the type of mass update:

e Update Rates for the current Effective Date.

e Create new Rates for this Effective Date.

e Remove Rate lines (Classifications) for the current Effective Date.

* Remove Rates for the current Effective Date which have not changed since last Effective Date.

6. In section 2, determine precisely what scope of the rate table will be edited (either Personnel,
Equipment, Material, Line Items, or all four sets of rates).

7. In section 3, specify the adjustment details (gives the choice of blanking out the rates, keeping the
current rates, or altering the rates by either an amount or percentage).

8. After the modifications have been made, click OK to adjust the rate table based on the parameters
you specified. The adjusted rate table will automatically refresh with the effective date and rates
altered accordingly.

9. When complete, click the Apply button or to save the changes and exit the window, click OK located
at the bottom of the page.
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1.31 CONFIGURING A PROJECT

Billings User Guide

When a project has been created in Platform and flagged as being Time and Materials, it is

automatically synced into Billings.

To configure the project for billings purposes, double-click the existing project from the list and go

through the tabs listed below.

Name

o

*LEM Demo
ST-1001 TEST
LEM Demo 2

Import Testing

Test CBS Integration
DEMO - UNIT RATE
Piping Install Demo
Test

Bilings Demo Project

Record 0 of 9

x| |([Status] = "Active’)

Code

111111.500
ST-1001
111111.500 2
IMPORT TEST
TESTCBS
DEMO-UR
Demao

1234

DEMO-BILL

Status
Active
Active
Active
Active
Active
Active
Active
Active
Active

Active

T  Intemal Code

Sample Ref #

Company Region
Defautt Defautt
Defautt Defautt
Defautt Defautt
Defautt Defautt
Defautt Defautt
Defautt Defautt
Defautt Defautt
Demo Supplier 2 Default

Default

Default

Edit Fitter

You can also manually create a new project by clicking the Add Row icon on the ribbon bar.

A project created manually in Billings will not be automatically created in Platform.

1.31.0.1 Configure tab

To select bill rates, click the Bill Rate Table drop-down list, and then select the rate table that contains

the bill rates that apply to the project.
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1.31 Configuring a Project

Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Bill Rates
Select the default rates to be used in the invoicing of this project (and child WES tems).
Bill Rate Table: -
Allow Override Timesheet Bill Rate
Cost Rates
Select the default rates to be used in the costing of this project (and child WBS items).
Cost Rate Table: -
Payroll Rates
Select the default rates to be used in the payrol of this project (and child WES tems).
Payroll Rate Table: -
Work Flow
Set whether or not timesheets against this project (and child WBS items) need to be approved prior to being invoiced.
Approval required
Budgeting
Set the level of detail of budgeting that will be used on this project. Once progress or budgets have been entered, you can no longer edit these values.
Budget By: -
Budget at Level: -
Custom Details
Dim 1:
Dim 2:
Activity Code:
o | ome
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Bill Rates
Select the default rates to be used in the invoicing of this project (and child WES tems).
Bill Rate Table: -
PO .....come0cor
[Internal] Non-project Specific - COST
Cost Rates ' [Internal] Shop/Yard Fadilty - COST
Select the default ratesto b (1 ternal] Shop/Yard Fadility - PAYROLL
Cost Rate Table: 180002, Encana Pipestone Liquids Hub - BILLING
180002, Encana Pipestone Liquids Hub - PAYROLL
Payroll Rates | 180003, MEG - PAYROLL (Inactive)
Select the default ratesto b 150,03 MEG Energy - BILLING (Inactive)
Payroll Rate Table: 180004, Encana TOWER 13-34-79-17 W6 PADSIT - PAYROLL
180005, Encana, Tower 6-16-080-17 W6 10 Well Pad - PAYROLL (Inactive)
Work Flow | 180006, Encana SCLH - BILLING (Inactive)
Set whether or not tmesht 13006, Encana SCLH - PAYROLL (Inactive)
Approval required 180008-33 - PAYROLL (Inactive)
180009-33 - PAYROLL (Inactive)
Budgeting | 180010-33 - PAYROLL (Inactive) v

Set the level of detail of bu %
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Select the applicable job Cost Rate Table from the drop-down menu, if desired, and finally select the
applicable Payroll Rate Table from the drop-down menu, again, if desired or required.

Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Bill Rates

Select the default rates to be used in the invoicing of this project (and child WBS items).
Bill Rate Table: .

Allow Override Timesheet Bill Rate

Cost Rates
Select the default rates to be used in the costing of this project (and child WES items).
Cost Rate Table: -
R a
payroll Rates [Internal] EQUIPMENT - COST
Select the defauk rates to § [Internal] Non-project Specific - COST
[Internal] Shop/Yard Fadility - COST
Payroll Rate Table: [Internal] Shop/Yard Fadility - PAYROLL
Work Flow 180002, Encana Pipestone Liquids Hub - BILLING
Set whether or not t . 180002, Encana Pipestone Liquids Hub - PAYROLL
180003, MEG - PAYROLL (Inactive)
Approval required | 180003, MEG Energy - BILLING (Inactive)
i 180004, Encana TOWER 13-34-79-17 W6 PADSIT - PAYROLL
Budgeting
180005, Encana, Tower 6-16-080-17 W6 10 Well Pad - PAYROLL (Inactive)
Set the level of detail of bu
180006, Encana SCLH - BILLING (Inactive)
Budget By: 180006, Encana SCLH - PAYROLL (Inactive)
Budget at Level: 180008-33 - PAYROLL (Inactive)
180009-33 - PAYROLL (Inactive)
CETEREES 180010-33 - PAYROLL (Inactive) v
Dim 1: =
Dim 2:
Activity Code:

Payroll Rate Table: =
[Internal] EQUIPMENT - COST =
[Internal] Non-project Specific - COST
[Internal] Shop/Yard Fadility - COST
Approval required | [Internal] Shop/Yard Fadility - PAYROLL
180002, Encana Pipestone Liquids Hub - BILLING
180002, Encana Pipestone Liquids Hub - PAYROLL
Set the level of detad of by 180003, MEG - PAYROLL (Inactive)
Budget By: 180003, MEG Energy - BILLING (Inactive)
180004, Encana TOWER 13-34-79-17 W6 PADSIT - PAYROLL

Set whether or not timesh¢

Budget at Level:
180005, Encana, Tower 6-16-080-17 W6 10 Well Pad - PAYROLL (Inactive)
i 180006, Encana SCLH - BILLING (Inactive)
Dim 1: 180006, Encana SCLH - PAYROLL (Inactive)
180008-33 - PAYROLL (Inactive)
Dim 2:
180009-33 - PAYROLL (Inactive)
Activity Code: 180010-33 - PAYROLL (Inactive) v

X
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If timesheet approvals are required for the project, check the Approval required check box. The main
result of this check box being set is that unapproved time sheets are not picked up for the LEM or
Invoicing process, or other exports which have time sheet approvals enabled.

Work flow can also be handled at the processing stage of the time sheet cycle. If you are
generating a LEM process, the process can be set to the ignore approval work flow, depending
on your organizational work flow requirements.

Select the level of detail you want the budgeting information to use if you wish to track project
budgets in Billings. Most projects require more than one level of detail in the project structure. You can
track budgets and progress at the Project/ WBS level or at the WBS/Cost Code level, depending on
your budgeting requirements.

Project Level 1 means the budget is being created at the root project level. If set to Project Level
2, the budget is being applied to WBS Level 1, second node of the project tree.
Budgeting

Budget By: Project

Budget at Level:

1.31.0.2 Line-ltem Markups tab

In the Default Markup Values section, enter markup percentage values for your charge out rates for
Line Items that are entered on time sheets.
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Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress

Default Markup Values

Line Items on timesheets will use the following markup percentages when calculating LEM amounts. Exceptions to these default percentages are specified in the table below.

Personnel line items are charged at cost plus
Equipment line items are charged at cost plus
Material line items are charged at cost plus
Line items are charged at cost plus

S S

Other line items are charged at cost plus

u | Invoice markups as seperate invoice items

Exceptions
The default percentages above may not be accurate for some of the resource type/line item combinations. Specify the exceptions here.

Personnel = Equipment = Material = LineItems  Other

Line Item Type Subcontractor Employee DSP Third Party FAC
- Material

Default Markup Values

Line Items on timesheets will use the following markup percentages when calculating LEM amounts. Exceptions to these default percentages are specified in the table below.

Personnel line items are charged at cost plus
Equipment line items are charged at cost plus
Material line items are charged at cost plus

Line items are charged at cost plus

E A

Other line items are charged at cost plus

®  Invoice markups as seperate invoice items
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Select the Invoice markups as separate invoice items if you want the markups to show on their own
invoice line, otherwise invoices will show fully marked-up amounts.

In the Exceptions section, enter any markup exceptions that apply to specific line-item types. These
values are entered as percentages.

Exceptions

The default percentages above may not be accurate for some of the resource type/line item combinations. Specify the exceptions here.

Personnel Equipment = Material Line Items = Other
Source
Line Item Type Subcontractor Employee DSP Third Party FAC
Material
Expense
3rd Party
Other
Consumables
Subcontractor
Equipment
Labour
Fuel
Transport & Freight
BURDENS - CPP
BURDENS - EI
BURDENS - Small Tool All...
BURDENS - Health
TEST

OK Cancel Apply

1.31.0.3 Cost Code tab

Click Add Row on the ribbon menu to add new cost codes to the project/WBS node selected. Billings
only allows charging of time and resources to a project node if cost codes have been associated with
the project or WBS node. If your project structure is complex, you would normally not attach any cost
codes at the root node, as they would be defined at the lowest level of the project/WBS tree structure.

(R Co
== ( oY X cut 14 sortBy Name Tl X
AddRow Delete Refresh ©undo ShowActve |1 sortByCode Direction: Close
= Only Asc
Projects Project: ©
) Add Q  Find Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
| EEE oo et ot et - e
Cost Code Desaription
: .
Cost Code Desaription o
<Add New CostCode>  <Add New Cost Code>
0 Bilable
1005 Survey
1006 Dewatering
1015 Grade

1020 Line Locating
1025 Hydrovac
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If you need to remove a cost code, select the line, then click Delete Row(s) from the ribbon menu.

Add as many cost codes to the node as needed to capture the required information during LEM data
entry. If the Project/Cost Code custom fields have been set up, you can populate them by clicking on
the small filter icon next to the cost code to open a list of the custom fields available.

1.31.0.4 Details/Notes tab

This tab lets you enter project specific data into custom fields that have been set up by the
administrator, along with general project notes.

Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Name Value

Travel Allowance Taxable?
Project Location/LSD

AFE No.

Client Ref. No.

[Company] Approval

Client Approval

Tax Code

Tax Rate

WBS Notes

Client Invoice Mapping

Apply time bumping

Time bump ST daily threshold
Time bump OT daily threshold
Time bump DT daily threshold
Time bump ST weekly threshold
Time bump stat holiday week threshold
Apply Site scope to time bumping
Time bump first day of week
Province Work Done In

Enable bill rate validation
Enable payroll rate validation

Enable cost rate validation

OK Cancel Apply

1.31.0.5 Equipment tab

Select the equipment filtering option that you want to apply to the project.
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* No Filter lets you to select any active piece of equipment, given the Region security filters.

e Filter by Site lets you to select only those pieces of equipment which have been associated with the
site to which the project belongs to.

e Filter by Schedule lets you to select only those pieces of equipment for which the work date falls
between the Start and End dates on the schedule page.

General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
m, Schedule assignment of equipment to this project and set the parameters to calculate its daily cost while assigned.

Pl

Specify how to filter the equipment list for timesheets entered against this project

{Filter by Schedule

Unit# Equipment Code Cost Classification = Start End Measure Daily Cost

a0c ac s l3 a0c = - ac -

Record 0 of 0

OK Cancel Apply

When Filter by Schedule is selected, you can click Add Row to add equipment that is used in this
project.
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= = C B cor X cut 14 sortBy Name Tl >

(B Paste
AddRow Delete Refresh ©Sundo ShowActive |1 sortByCode Direction: Close
" Only Asc

Add Row Project ©

D Ad Y Find General Configure Line Item Markups Cost Code Detais/Notes Budget Progress

. Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mabie Configuration

o Schedule assignment of equipment to this project and set the parameters to calculate its daily cost while assigned
’

Specify how to fiter the equipment lst for tmesheets entered against this project

Fiter by Schedule

Unit# Equipment Code  CostClassification  Start End Measure Daily Cost

e e e = = o =

Enter the assignment start and end dates as well as unit of measure and quantity to use in calculating
the daily equipment cost.

The rate used in this calculation will be extracted from the Cost Rate Table set up for this project
on the Configure tab.

1.31.0.6 Crew tab

Select the personnel/crew filtering option that you want to apply to the project.
* No Filter lets you to select any active person from the personnel list, given the Region security filter.

e Filter by Site Personnel List lets you to select only those individuals who have been associated with
the site to which this project belongs.

e Filter by Selected Crews lets you to select only those individuals who belong to the crews selected in
the rows below from the crews defined for the site this project belongs to.
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General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration

o If required, limit which crews may work on this project by adding them from the pre-defined site
wae cewlist.

Specify how to filter the personnel list for timesheets entered against this project

Filter by selected crews

Code Name Type Notes Message

- ol e e oc ol

OK Cancel Apply

If Filter by Selected Crews is selected, select which crews will be working on this project by selecting
the Add Row icon located on the ribbon menu.

Crews are defined at the Site level, which is identified in the General tab of the Project.

1.31.0.7 Material tab

Select the material filtering option that you want to apply to the project.
* No Filter lets you to select any active material from the material list, given the Region security filter.

e Filter by Site lets you to select only those materials who have been associated with the site to which
this project belongs to.
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e Filter by Materials lets you to select only those materials that belong to the materials selected in the
window below.

General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
---' If required, limit which materials may be used on this project by adding them from the material
list.
--

Specify how to filter the Material list for timesheets entered against this project

Filter by Materials

Code Name Region Company
afJc afc ac afJc

Record 0 of 0

OK Cancel Apply

1.31.0.8 time sheet Options tab

In the Multi Day time sheet, section set the number of days that will appear by default on a Multi Day
time sheet.
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General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
Multi Day Timesheet
Set the default number of days that will appear on a multi day timesheet (Max 31)
Days:
Timesheet Numbering

Use project specffic timesheet numbering

Start T/S# at:

digits

T/S# Template:

Prefix:

suffix:

Example:

The time sheet Numbering section lets you set up the prefix or suffix for the name you want to use in
the naming of your time sheets. It also lets you set the starting number and number of digits you want
to use. If you want to allow users to override the time sheet number, check the Allow user to override
T/S number option.

1.31.0.9 Work Order tab

You can add work orders that will be available on the time sheet page. To add a new work order, from
the Work Order tab, select the Add Row icon located on the ribbon menu. When the new row appears
on the page, provide all applicable information, then click Apply.
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General Configure Line Item Markups Cost Code Details/Notes Budget Progress
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
Code Description Start Date Close Date Client Contact Status HD Phase Code
afc afc = = afJc = afc

Record 0 of 0
OK Cancel Apply

1.31.0.10 Pay Items tab

Pay Items will be automatically populated from Platform if they have been defined. However, you can
also manually add pay items that can then be used on individual WBS items to group them for billing
purposes. To add a new pay item, from the Pay Items tab, select the Add Row icon located on the
ribbon menu. When the new row appears on the page, provide all applicable information, then click

Apply.
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General Configure Line Item Markups Cost Code DetailsMotes
Equipment Crew Material Timesheet Options Work Order
Attachments Mobile Security Mobile Configuration Pay Items
Drag a column header here to group by that column p
Pay Item # Pay Item Description Status T
T e e
- [cinis
Fixed Final Price Fixed Final Price Active
Time and Material Time and Material Active
Unit Price Unit Price Active

0K

Edit Filter

Attachments tab

You can upload any pertinent documentation for this project on the attachments tab.

1. To add an attachment, click the Add Row icon located on the ribbon bar.

2. To delete an unwanted attachment, select the row to be deleted by clicking it once and then click

the Delete Row(s) icon located on the ribbon bar

3. After the new row appears, click the Folder icon in the new row in the Attachment column, to select

the document you want to upload.
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General Configure Line ttem Markups Cost Code Details/Notes Equipment Crew
Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration Pay ltems
Drag a column header here to group by that column ,D
Attachment Type File Date Status
e
= L O

4. Locate the document in your folder structure, and then select it.
The attachment name shows in Attachment.

5. Select the type, file date and status from the columns, and then click Apply or OK.

WBS Structure

After all the project tabs have been populated with the required information, you can create the WBS
structure.

1. To add a WBS item to a project, right-click the project, and then select Add WBS.

Alternatively, you can click the Add button, located directly above the project name to add a new WBS
item.

@ A Remove Material Timesheet Options Work Order Atachments Mobie Secuy Mobie Corfiguration Pay kems
o o T General Corfigure Line tem Markups Cost Code Detalls/Notes Equipmert Crew
ostion = Code escrption
= - I “LEM Demo
UNASSIGNED UNASSIGNED @ Addwes e -
1 998 Accounting Code 1 Collapss Fode: 111111.500
2 959 Accouriing Code 2 B Position
E 1000 Insurance - Net ncludzd n Mark Up Cal ~~ "o P
4 1002 GC Bond Calcuation = Ful Collapse
Company: Defaut
5 1004 SDI (571 SU/S1000) - Dect Cot A By To Lowel o
5 1005 Procore Charge

1006 Tech Services Charge Colapse To Level

2. Enter the name of the new WBS and the Code or abbreviation to be used for this item and the PO
number if required.

3. All other fields under the general tab are optional unless instructed otherwise by the administrator
or required for the job. If left empty, these fields inherit values from the parent node, or the parent’s
parent node.
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Unless a different set of rates needs to be used on this node than those set up at the project
node, nothing needs to be set up under the Configure tab. Rate table assignment also follows
the inheritance rules as above.

4. To capture data on a time sheet against the project, cost codes must be applied to the project,

either at the project node (not recommended), or at the WBS nodes.

5. To apply cost codes, click the Cost Code tab of the applicable project or WBS node .

Cost Code

Description

Cost Code

<Add New Cost Code>
00

1005

1006

1015

1020

Description

<Add New Cost Code>
Billable

Survey

Dewatering

Grade

Line Locating

_mv

X

6. Click the Add Row icon located in the ribbon bar, then select the drop-down menu to choose the

cost code.

The Budget and Progress tabs are only visible if you specified budgeting configuration information at

the root node of the project in the Configure tab.
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Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration

General Configure Line Item Markups Cost Code Details/Notes Budget Progress

Use the filter criteria and the button below to retrieve the sum of budgets for this project.
a4

Show budget type: Progressive
Show budget effective as of: | Jan-30-2023 - Retrieve
Budget Item Cost Code Qty Hours $ Amount
Equipment Crew Material Timesheet Options Work Order Attachments Mobile Security Mobile Configuration
General Configure Line Item Markups Cost Code Details/Notes Budget Progress

/i/l'i Track the completion percentage for this project by date using the grid below.
n

Show progress effective as of: = Jan-11-2023

Effective Date CostCode % Complete Units Installed

7. In the Budget and Progress tabs, you can retrieve information on the selected job to view.
8. Click Apply to complete the setup of the node.

9. Continue to create additional WBS items and any child WBS items that are further required following
the steps above.

10. Using the Configure tab of a WBS item, select the applicable pay item that this WBS item belongs to
(this might be pre-populated from InEight Control if pay items are maintained there)

10. After all folder levels have completed, click OK to save the project and exit the page.

11. After all folder levels have been completed, click OK to save the project and exit the page.

To view the list of projects that have been set up, click on File, Open and Project.
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1.31.1 Platform project association

You can associate Billings with additional master data, such as project data from the Project details
page in Platform. Associating Platform projects lets you organize Billings directly from Platform’s
Organizational Breakdown Structure (OBS). Your location assignment in the OBS determines the access
you inherit and your visibility to other OBS areas.

Extracting Platform project master data directly into Billings promotes data consistency and helps
ensure that the data is being pulled from a single source of truth.

Platform project-specific master data can be maintained in one place, then it can flow directly into
Billings in the cloud.

Material Timeshest Options Work Order Attachments Mobile Security Mobile Configuration Pay ltems
General Configure Line tem Markups Cost Code Details/Motes Equipment Crew
a
Name: “LEM Demo
v Code: 111111.500
Position:
Company: : Default
Bill To:
Site:
PO #: Sample PO #

Internal Code: Sample Ref &

Division: -
Status: Active N
I Project: I -
oK Cancel Apply
= )  +LEMDemo|111111.500 / Project details DEMO(PTR2) ® L ©® ®

All projects & organizations >  Edit project DETAILS INFORMATION ATTRIBUTES

Project settings

Project details

* Project ID *External project ID @ Notes
111111.500 111111.500
+ * Name * Status
Add project image
*LEM Demo Active v

Minimum of 540px x 360px

*Phase @ * Organization

Sreeuten . Recount oot oraanzztion o
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If the Billings project was created in Platform, the Project name, Code, and Position fields are disabled
and can only be managed in Platform.

1.32 MANAGING A SITE

Sites are automatically created when a Project is created during synchronization with Platform. The
project’s name and code are used for the Site Name and Code fields. The purpose of sites is to
maintain project specific resources for use in Billings. The labor and equipment named resources, as
well as vendors, assigned to the Project in Platform, are reflected in the Personnel, Equipment and
Companies tabs.

To view the list of all sites that have been set up, go to Project Administration > Sites. The available
columns on the Sites tab are as follows:

e Name
e Code
* Region

e Status

1.32.0.1 Personnel Tab

The Personnel tab shows the current resource assignments and is split into two sections, Assign People
and Create Crews.

If there are missing resource assignments that are required for billing purposes, and they cannot be
added to the project operational resources in InEight Progress , you can click Add Personnel to add
additional resource assignments. A window shows with the names of available people. Double-click on
each individual resource, or single select (highlight) all resources required and click OK. Once all
required resources have been added to the Personnel tab, click Apply to save the updates.
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Assign personnel to the site by using the 'Add Personnel' button. Once assigned, you can group personnel into crews, as well as
©  items related to this site to limit the tmesheet personnel lists to this pre-assigned list.

[@ Add Personnel | X Remove Personnel

Code Last Name First Name Bill As Cost As shift ... Sync Status Order :
T e afc Afc Alc aJc aflc o = = [

S Personnel Resources

Code Last Name First Name Source BilingClas... CostClassi... S... Region Compan:

T af)c e aflc afc afc afc alc  afc afc
e s lem ek |eaive | oeane 0| Abwia | Gnoan
1599 Witter Howard Emplo... TruckDriver = Truck Driver @ D... Alberta Compan:
1761 Gerstel Crystal Emplo... Manager -... Manager -... D... Alberta Compan:
2338 Krawiec Ken Emplo... Executive ... | Executive ... D... Alberta Compan

X Status = Active

Refresh OK

Record 0 of 0 4
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On the right side, you can further restrict who can work on any one project by creating site crews and
assigning personnel to each specific crew they are associated to.
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Create site crews and add personnel to them by dragging and dropping the personnel rows from the left side of the «
32 button. You can override the personnel attributes within a crew.

(® Add Crew X Remove Crew

Drag a column header here to group by that column

Code Name Type Notes
Y = ac afc = aflc
, H %
Record 1of 1
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Click the Add personnel button located above the Personnel tab to launch the Personnel List dialog
box. You can select multiple records using the mouse and holding the Ctrl key to select each applicable
record, or select a range of records by selecting the first record, holding the Shift key, and then
selecting the last applicable record. Click OK to bring the selected records to the page.

S Personnel Resources m] X
0
Code Last Name First Name Source BilingClas... CostClassi.. S.. Region Company Payro... . Y
T afc afc ac Ac alc  Afc ac Las = =
——mmm--mm
1761 Gerstel Crystal Emplo... Manager - ... Manager - D... Alberta Company OnP.. | Act.
m_mm--mm
Thibault Emplo...  Estimator - 1 ' Estimator -1  D... Alberta Company OnP..  Act.
—m—mm--mm
2568 MacMullin Kevin Emplo Superinten Superinten D Alberta Company . Act.
E-——mm--m-
Sagert Laurence Emplo... Warehous... Warehous... D... Alberta Company Act..
> __EI-E-- Onp?"""'l
30019 Watts Clint Welder -B ... Welder -B ... D... Alberta DSP Comp... On P
30024 Anderson Barry DSP Constructi Constructi D...  Alberta DSP Comp OnP Act..
30027 Cross Brymer DSP Pipefitter -... = Pipefitter -... D... Alberta DSP Comp... OnP.. Act.. .
x v  Status Active Edit Filter
Refresh ‘ OK ‘ Cancel

After an individual is assigned to the site, additional details can be entered, such as timesheet entry
display Order, Site Code (usually customer driven), Shift Rotation, Start Date, End Date, and User Def 1-
4. The Shift Rotation is populated from the Personnel tab by default (if assigned on the global resource
record) but can be overridden. Shift Rotation selections are defined in the Options menu under the
Drop-Down List Setup, Shift Rotation Type.

You can override a worker’s default Bill and Cost Classifications while they are part of the crew,
by changing the Bill As and Cost As fields for the individual. These changes will be the new
default for time sheets when using these resources on a project, where the project has the crew
option enabled (Project Administration Project Crew Filter by selected crews).

Use the right side of the page to create crew definitions for the site. Create crews by using the Add
Crew button, located at the top of the page. Enter the crew’s name and assign the crew a code, then
click Apply.
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An individual can be part of multiple crew definitions at the same time. To view the crew
list, expand the crew definition by using the + button next to the crew code.

1.32.0.2 Equipment tab

The Equipment tab lets you view and maintain a list of equipment attached and assigned to the site.
User Def 1-4 can be set in the Site List. Select the Add Equipment button, located at the top of the page
to show the Equipment List dialog box. You can select multiple records using the mouse and holding
the Ctrl key to select each applicable record or select a range of records by selecting the first record,
holding the Shift key, and then selecting the last applicable record. Click OK to bring the selected
records to the page.

1.32.0.3 Materials tab

The Materials tab lets you view and maintain a list of material attached and assigned to this site. User
Def 1-4 can be set in the Site List. Click the Add Material button, located at the top of the page, to
bring up the Material List dialog box. You can select multiple records using the mouse and holding the
ctrl key to select each applicable record, or select a range of records by selecting the first record,
holding the shift key, and then selecting the last applicable record. Press OK to bring the selected
records to the page.
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Sites site ©

General = Area  Personnel  Equipment  Material | Contact

smm  Assign material to the site by using the ‘Add Material’ button. Once assigned, you can configure project/WBS items related to this site to limit the timesheet material lists to this pre-assigned list.
-
® AddMaterial || X Remove Materia
0
Code Name Region Company UserDef1  UserDef2  UserDef3  UserDef4
s e e e e e e e
121 Material Resources
L0
Code Name Regon Material Type | Biling Classification Status T Company
o | e e e o0c = Active 0e
T T N T TN LS T
x [v| | Status = Actve Edit Filter
Refresh oK Cancel
Record 00f0
oK Cancel Apply

1.32.0.4 Companies Tab

The Companies tab is used to assign companies to the site by using the Add Company button. When
assigned, you can configure project or WBS items related to this site to limit the timesheet company
lists to the pre-assigned list.
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one
C X

Refresh Close

Rate: EX1 Project: “LEM Demo Sites Site: Default ©

General Hrea Personnel Equipment Material Companies Contact

E Assign companies to the site by using the ‘Add Company’ button. Once assigned, you can configure project/WBS items related to this site to limit the timesheet company lists to this

pre-assigned list

(®) Add Company | | > Remaove Company

Mame Code Relationship Type UserDef1 UserDef2 UserDef3 UserDefd
e Afc =4 e Afc e Afc

Record 0 of O

OK Cancel Apply

1.32.0.5 Contacts tab

The Contacts tab lets you view and maintain a list of contacts associated with this site. Click the Add
Contact button located at the top of the page, to add additional contacts to this list.
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1.33 TIMESHEETS OVERVIEW

1.34 UNDERSTANDING TIMESHEETS

Timesheets get posted to Billings in the following ways:

Creation of a daily plan that is set to Approved

Creation of a weekly time sheet

Manual creation of a time sheet directly in Billings

Submission of a timesheet from the Billings Timesheet mobile app

External system that publishes billing related records directly into Billings via APIM feed

Time sheet import, where a user manually uploads a time sheet into Billings

Billings supports the following types of time sheets:

Single Day, Single Project
Multi Day, Single Project
Multi Day, Multi Project
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To view the time sheets tab and all time sheets that exist in the system, go to time sheets > time
sheets.

The available columns on the time sheets tab are as follows:
e Timesheet #
e Work Date
e Timesheet ID
e Job#
¢ Root Project
* Name
e Region
e Company
e Days
e Status
* Type
e Approval Status
e Close
e Created By
e Created Date
e Timesheet Total
¢ Modify By
¢ Modify Date
e Park

1.34.0.1 Time Sheet Status Rules

Timesheet and Approval

Timesheet Status Status Rules

Open All items contained on the time
sheet can be modified or
deleted, and new items will be
added if you have the
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Timesheet and Approval

Timesheet Status Status Rules

applicable security
permissions.

Locked The time sheet contains items
that have been invoiced or
exported. Exported or
invoiced time sheet line items
cannot be modified or deleted
but new lines/items can be
added or modified by an
Administrator or Power User
until they too are invoiced or

exported.

Closed Time sheet cannot be
modified

Pending Approval All items contained on the

Time sheet can be modified
or deleted and new items will
be added, providing the user
has security permission.

User Defined (optional) All items contained on the
Time sheet can be modified or
deleted and new items can be
added, providing the user has
security permission.

Un-invoiced Time sheet cannot be
modified. Un-invoiced Time
sheet items will be eligible for
invoicing. Time sheet status
must be changed to Pending
approval or user defined
status to make any
modifications.
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Timesheet and Approval

Timesheet Status Status Rules

Parked Time sheet is temporarily
unavailable for exporting and
invoicing until Parked status is
removed. When Parked status
is removed, time sheet returns
to the status it had prior to
being parked.

Creating a Single Day, Single Project time sheet

1. To create a single day, single project time sheet, go to Timesheets > Timesheets.

Timesheets

Templates

2. From the ribbon bar, select the timesheet type by using the drop-down arrow on the New icon, and
select Single Project - Daily. A new Timesheet window opens.

= -] X
HOME (m]
— T == Copy Kot | et = ® E
X : EZ . W B Pin
New Delete Refresh Generate Viewlods Create Sundo @ PrintPreview  SendTo  View: Al Layout  Close
> Row(s) Line Items Template o - -
Single Project Daily Edit Print Save Filter Window
Mutti-Project > Weekly ;
Timesheet = Type Timesheet ID Job # Root Project Name Region Company Work Date Days Status v
s = e e e e e e = = # Closed .
Sy Tses oo | oao " mmmosren T
0000019389 Single Day Timesheet 0000019389 Kennedy QA Test Kennedy QA Test(Ken...  Aberta Techmation Electric & Cont...  Jan-15-2023 1 Open
Copy of 0000019386 Single Day Timesheet 0000019388 DEMO KIEWIT DEMO(DEMO)  Aberta Mining Company Jan-14-2023 1| Open
0000019386 Sindle Dav Timesheet 0000019386 DEMO KIEWIT DEMO(DEMO) Alberta Minina Comoanv Jan-13-2023 1 Ooen

InEight Inc. | Release 25.9 Page 105 of 154



1.34 Understanding TimeSheets Billings User Guide

3. Click the three dots icon located to the right of the Project field. A Project search display opens.

4. Find and select the Project that this timesheet is for by using the Project Root or Code drop-down
list.

Timesheets Timesheet - Single Day:  ©

Project: T/SID: Ordered By.
Regon: - | Company T # Location Biled To
Client #:

© Project o x /S Totak $0.00
ProjectRoot: | KIEWIT DEMO

Code: {DEMO

Persomel | Equipment = Material  Lineltems = Detais  Diary | 4

Cancel

Multi Line Entry. Park Close  Last Created T/S #

The project work breakdown structure (project tree) will appear in the main area of the Project display.

5. Select the applicable project folder by double clicking it. This returns the name of the folder selected
to the Project field on the Timesheet entry page.

Selecting a more detailed level of the project using the tree picker filters the available
project/cost code paths when entering Labor, Equipment, Material, and Line Items.

6. The project name will be filled in the Project field in the time sheet entry screen. The Region and
Client fields will default to the selected project’s region and client values (or those inherited from the
parent tree nodes of the selected project tree structure).
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T/5ID:

Job #:

1.34 Understanding TimeSheets

T/S Totak $0.00

7. If the selected project has been configured to use automatically generated Timesheet numbers, skip
to the next step; otherwise click on the Timesheet # field, and then enter the unique Timesheet

number for this Time sheet.

You can leave the Time sheet # field blank, in which case the Time sheet # field is automatically
generated by the database and matches the system generated Time sheet ID.

8. In the Date field, select the date when the work was performed.

T/SID: Ordered By:
TS # Location Billed To:
Job #: Client #:
Date: Jan-30-ZiFE T/S Totak $0.00
onday, January 30, 2023
4 January 202 r
U MO TU WE TH FR SA
2 3 4 5 6
9 0 2 13 4
15 16 17 18 19 0 21
Cost Code I, _ - oT DT DTH

1.34.0.2 Personnel Tab

There will be several columns listed in the Personnel tab, as well as some columns hidden. However, to
speed up the process of data entry, it is beneficial to remove or add only the necessary columns.

If a column from the Personnel tab is needed on the Time sheet layout, you must add it before data
can be entered into it. Right click any column header, and then select Column Chooser to view this list.
You can then drag and drop any of the additional fields into the Timesheet view or remove any fields
that are not required.
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onnel | Eguipment = Material  Lineltems = Detsis Diary = Attachments

.00 .00 .00 .00 .00 .00 .00

You can control where the new column will be displayed on the page by dragging and dropping
the column headers in the desired location, as identified with the black line.

After a layout has been created or modified with the columns relevant for data entry, save the layout
by expanding the Layout drop-down menu and then selecting Save As. A window opens, to allow you
to name the layout. This layout is specific only to you. It is not available to other users unless you or an
Administrator share it. After the layout has been saved, you can click Set Default, which makes it the
default view when you enter the Timesheet page in the future.

When creating a timesheet layout, keep in mind that multiple layouts can be created and saved.
It can be beneficial for the user to create a layout for when they are entering data and another
layout for when they are auditing the data entered.

After the layout has been modified, go into the Personnel field on the page and either begin typing the
last name or use the drop-down menu to pull up a list of personnel.
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personnel | | Equpment = Material  Lineltems Detsis Diary = Attachments

Unit = Personnel | Name

Personnel Code Bil As

Name Code Classificaon  Classification

Aaron Brewst. r ... KCABSR
Aaron Frick A -... KC-WDCWB
r ... KCABSR
PF-IM

PF-IM

Abd Hirole Abdi
AbdiHussein | 30937

174112

KC_Labourer
Pipefitter - Jo... | PF-JM

KCABSR

Region
Alberta
Alberta
Alberta
Alberta
Alberta
Alberta

Alberta

ost As shift

or ot DTH ™

1.34 Understanding TimeSheets

Cost Code sT LoA Day
Status
Active
Active
Active
Active
Active
Active
Active

.00 .00 .00 .00 .00 .00 .00

The Bill As, Cost As, and Shift fields automatically populate with the default values specified for the

person selected. However, if the person whose time is being entered is to be billed out or cost as
another classification, the Bill As or the Cost As field(s) can be changed to the appropriate personnel
classification to ensure the time sheet is invoiced and cost coded appropriately. For example, if a

Journeyman is promoted for a day, since it is a temporary change to the classification, the Bill As field

can be changed as needed on a single timesheet line/item without changing the person’s default

classification.

1.34.0.3 Cost Code Field

Press the Tab key to go to the Cost Code field. Click the drop-down to display a list of cost codes

defined for the selected project node (and any child WBS items). How the project is set up determines

how the cost code list is shown.

Persomnel | Equipment = Material  Lineltems = Detals Diary = Attachments

Personnel Name Personnel Code  Bil As

InEight Inc. | Release 25.9

CostAs shift

Unit #

Cost Code st or oT DTH ™ LoA Day

Cost Code

<Edit Cost Code List>

The list of cost codes is embedded in a project path. This path is created by following the folder
levels of the WBS structure so that the costs are allocated to the proper area. For example, if
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he path is 1/EXT/PIP/11.01, this means that the costs are going to Plant 1, Extraction Area,
iping, and Cost Code 11.01.

The next set of fields determines the billing type for the units. Dependent on the project contract,
Personnel can be billed out for ST, OT, DT, DTH, TT, Day, and LOA.

If multiple personnel are being used for the job, click on the Add Row icon located on the ribbon bar to
add a row, or use the Tab key to move all the way to the right of the page and press Tab again to
generate a row.

Billings automatically copies most of the information from the previous row to a new row. To
remove a row, click the Delete Row(s) icon located on the ribbon menu.

1.34.0.4 Equipment and Material Tabs

Perform similar steps to enter equipment on the Equipment tab, and materials on the Material tab.
Both Equipment and Materials that appear from the drop-down list will be filtered if the project that
the time sheet is being charged against has been set up to filter the Equipment or Material lists.

= Code Bl As Cost Code Measure Quantity
- R B0 neoumroenn N [ S R

1.34.0.5 Line Items Tab

When there is data that needs to be entered, but it does not fall within the predefined units of
measure on the Personnel, Equipment, or Materials tabs, you can enter it on the Line Items tab.

Page 110 of 154 InEight Inc. | Release 25.9



Billings User Guide 1.34 Understanding TimeSheets

0.00 $0.00

The Line Items tab offers the flexibility to enter any other items that are related to the time sheet that
do not neatly fall into the predefined categories of Personnel, Equipment or Materials. This can include
expenses, premiums and allowances, surcharges, rental fees, or other additional fees that are related
to the time sheet. If required, a line item can be assigned to a person (e.g., small tools allowance,
equipment rentals, other premium, etc.), a piece of equipment (such as., repairs, additional charges),
material (such as, a hauling charge), or entered as an Other line item.

The Line-ltem tab lets you:
¢ Allot a Custom Description to the item
e Charge it to a cost code (required)
e Attach it to an applicable PO #
¢ Assign a unit of measure
e Track the quantity

¢ Key the rate instantaneously

1.34.0.6 Details Tab

The Details tab lets you capture any field notes associated with the time sheet and also enter data into
any custom time sheet fields set up by the application administrator.
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Personnel  Egupment  Material  Lineltems Detals Diary Attachments
Notes Name Value

Exdude From Time Re-Allocation

Additional time sheet details can be captured in the Diary tab.

Did any incidents occur today that need to be reported? If so, please describe.

What other information s relevant to support noted items from the Daily Diary Checklist?
Temperature

When you're done entering data into the time sheet, click on Apply or OK.

The Park and Close fields affect time sheets that need to be put on hold or closed.

To view the Time sheets tab and all time sheets that have been created, select Timesheets >
Timesheets.

The available columns on the time sheets tab are:

¢ Time sheet #

e Work Date
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e Time sheet ID
e Job#

¢ Root Project

* Name

e Region

e Company

e Days

* Status

e Type

e Approval Status
e Close

e Created By

e Created Date

e Time sheet Total
¢ Modify By

¢ Modify Date

e Park

Creating a timesheet layout

1. Right click any column header and select Column Chooser to view this list.
You can then drag and drop any of the additional fields into the time sheet view or remove any fields
that are not required.
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21 Sort Ascending
Z1 Sort Descending
Clear All Sorting
l Group By This Column
4° Hide Group By Box
Hide This Column
=| Column Chooser
+a+ BestFit
Best Fit (all columns)
Y Filter Editor...
Show Find Panel
Show Auto Filter Row
Filter Mode >

My Column Caption

You can control where the new column will be displayed in the grid by dragging and dropping
the column headers in the desired location. You can also select My Column Caption to rename
the column headers.

2. After you have created a layout with the columns relevant for data entry, you can save the layout by
selecting the Layout drop-down from the top right side of the tool bar.

3. Click Save As.

The Save Layout As dialog box opens, and you can name the layout.

This layout is specific only to the user logged into Billings. It will not be available to other users unless it
is shared by the user or an Administrator.

4. After the layout has been saved, the user can select Set Default which will make it the default view
when they access the Timesheet page in the future.
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mE X

Layout Close

-

Save As...
System Default
Set Default

Remove Default

InEight Billings X

Save Layout As...

OK Cancel

1.35 CREATING A MULTI-DAY, MULTI-
PROJECT TIMESHEET

Create a multi day, multi project time sheet

1. To create a multi-day, multi-project time sheet, go to Timesheets > Timesheets.
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=D

Timesheets

K

2

&
S
B

E

Templates

&

2. From the ribbon menu, click the New icon, and then select Multi-Project > Daily. A new Timesheet
window opens.

el |
H=C + @&

New Delete Refresh Generate View Locks
v Row(s) Line Items

Single Project »
Multi-Project » Weekly

3. Click the Timesheet # field and enter in the number of the time sheet.

You can leave the Timesheet # (T/S) field blank, in which case the Timesheet # will automatically
generate from the database and will match the system-generated Timesheet ID.

4. Click the Start Date drop-down arrow and select the starting date of the time sheet (that is, the first
day the work was performed or the first day of the shift).
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TS ID: Job #: Ordered By:

Tfs # Start Date: Feb-01-2023 ~ Location Biled To:
Region: Payrol (EMP &DSP) ~ | Number of Days on T/S: 5% Client #:
Division: ~ | Company:

5. Adjust the Number of Days on Timesheet if needed.

6. Click the three dots icon next to Company field to select the client this work was done for.

Timesheet - i Proje o
TS I: Job #: Ordered By:
T #: Start Date: Feb-01-2023 ~ Location Biled To:
Region: Payroll (EMP &DSP) ~ | Number of Days on T/S: 53 Client #:
Division: ~ | Company =]

Thu Feb-02-23

Personnel Code  Personnel Name il As LOA DAY ST OT DT DM TI LOA DAY ST  OT

Name Code Relationship Type Status v
o o o = Active 2
SemCAMS ULC 1063 Clent Active
Ovintiv Canada ULC 1031 Client Active
Canadian Natural Resources Limited 1061 Clent Active

x [v| | Status = Active Edit Filter

Refresh oK Cancel

1.35.0.1 Personnel tab

The Personnel tab includes columns that might normally be hidden. To speed up the process of data
entry, it is beneficial for you to include only the necessary columns.

1.36 CREATING A MULTI DAY, SINGLE
PROJECT TIMESHEET

Create a Multi Day, Single Project time sheet

1. Go to Timesheets >Timesheets

2. From the ribbon menu, click the New icon, and then select Single Project - Weekly.
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Timesheets Timesheet - Single Day: © -
Project: DEMO(DEMO) TSID: Ordered By:
Region: Aberta ~ | Company: Mining Company - TS Locaton Biled To:
Division: - Client #:
Date: Jan-30-2023 ~ T/S Totak $0.00
Personnel  Eguipment = Material  Lineltems ~Detals Diary  Attachments
Did any of the Crew experience an injury today that was not reported? If so, please describe. ST Conversations W/ Owner
Work Performed Visitors to Site:
X-tra Work Performed Equipment Damage
Cost Impacts Other Observations
Schedule Impacts Incidents
Did any incidents occur today that need to be reported? If so, please describe. el I
Weather Conditons
What other information is relevant to support noted items from the Daily Diary Checkist?
Temperature
Park Close  Last Created T/S #: V| New T/S after Apply oK Cancel Apply

3. Click the elipses icon located to the right of the Project field and select the project that this time
sheet is for by using the Project Root or Code drop-down list.

Timesheets Timesheet - Single Day: © -
Project KIEWIT DEMO(DEMO) T/SID: Ordered By:
Region: Aberta - | company: Mining Company TS #: Location Biled To:
Division: - Job Client #:
= st 00
ProjectRoot: | KIEWIT DEMO -
Code: DEMO -
persomel | Equipment = Material | Lineltems = Detals Diary £ e
ap
BMT Burnaby Mountain Tunnel(1892)
Did any of the Crew experience an injury today that was not reported? If o, § » (57 Secd 7872 C TS
> | ST Sumas Terminal(3052) Visitors to Site
Equipment Damage
Other Observations
Incdents
Did any incidents occur today that need to be reported? If so, please describe ans
What other information is relevant to support noted items from the Daily Diary
ok Cancel
Park Close  LastCreated T/S #: | New T/S after Apply oK Cancel Apply
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4. The project name is auto-filled. The Region, Division, and Company fields are automatically
populated based on the project selected.

Project: DEMO(DEMO) T/SID: Ordered By:
Region: Alberta ~ | Company. Mining Company TS #: Location Biled To:
Division - Job #: Client #:

Jan-30-2023 T/S Totak $0.00

5. If the selected project has been configured to use automatically generated time sheet numbers, skip
to the next step. Otherwise, click on the Timesheet # field and enter in the number of the timesheet.

You can leave the Timesheet # field blank, in which case the value in the Timesheet # field is
automatically generated by the database and matches the system-generated Timesheet ID.

6. Select the starting date of the time sheet (that is, the first day the work was performed or the first
day of the shift).

T/S ID: Ordered By:
TS # Location Billed To:
Job #: Client #:
Date: Jan-30-HiEE T/S Totak $0.00
Tuesday, January 31, 2023
< January 2023 »
SuU O TU NE TH FR SA
1 2 3 4 5 6 7
8 9 10 11 12 13 4
15 16 17 18 19 20 21
Cost Code oT DT DT+
2 23 24 25 26 27 28
q-F

7. Adjust the Number of Days on the time sheet if needed.

The Personnel tab includes columns that might normally be hidden. To speed up the process of data
entry, it is beneficial for you to include only the necessary columns.

The Bill As, Cost As, and Shift fields automatically populate with the default values specified for the
person selected. However, if the person whose time is being entered is to be billed out or cost as
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another classification, the Bill As or the Cost As field can be changed to the applicable personnel
classification to ensure the time sheet is invoiced and costed appropriately.

For example, if a Journeyman is promoted for a day, since it is a temporary change to the classification,
the Bill As field can be changed as needed on a single time sheet line or item without changing the
person’s default classification.

Press the Tab key to move to the Cost Code field.

Click on the drop-down arrow to display a list of cost codes defined for the selected project node (and
any child WBS items). How the project is set up determines how the cost code list shows.

The next set of fields is used to capture the quantity of hours worked per type of hours. Depending on
the project contract, personnel hours can be recorded against ST, OT, DT, DTH, TT, Day, and LOA.

If time for multiple persons is being used for the job, click on the Add Row icon located on the ribbon
bar to add another row, or use the Tab key to move all the way to the right of the page and press Tab
again to generate a row.

Billings automatically copies most of the information from the previous row to a new row. To
remove a row, click on the Delete Row(s) icon located on the ribbon menu.

If you are entering the same data for multiple personnel rows, it is more efficient to use the multiline
entry dialog box than manually entering individual rows. The multiline entry dialog box lets you select
several personnel records and apply same cost codes, quantities, and units of measure to these rows in
one step. If you select multiple cost codes, multiple rows are created for each personnel record and
cost code record selected.

1.36.0.1 Equipment and Material tab

You can follow the same functionality to enter equipment on the Equipment tab, and materials on the
Material tab that you followed for the Personnel tab.
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Personnel  Equpment  Material  Lineltems Detals  Diary = Attachments

joj
Unit # Equipment Code Bil As Cost Code Measure Quantity

- [m N S T I S

Record 10f 1

Some columns are normally less used so they must first be added to the Timesheet layout before data
can be entered into them. Right-click any column header, and then select Column Chooser to view this
list. You can then drag and drop any of the additional fields into the Timesheet view or remove any
fields that are not required.

You can control where the new column displays on the page by dragging and dropping the
column header to the desired location.

Personnel | | Equpment = Material  Lineltems = Detsis Diary = Attachments

Unit = Personnel Name Bil As CostAs shift Cost Code st LoA Day

¥ Darcannal Cada or oT DTH T
- I 2 serhecendng [N I N N N N U N S S R R
Hl

Sort Descending

" Group By This Column

4% Hide Group By Box
Hide This Column
=/ Column Chooser
A+ BestFit
Best Fit (all columns)
Y Filter Editor.
Show Find Panel
Show Auto Filter Row
Filter Mode »

My Column Caption

.00 .00 .00 .00 .00 .00 .00

Record 10f 1

1.36.0.2 Line Items Tab

The Line Items tab offers the flexibility to enter any other items related to the timesheet but that do
not neatly fall into the predefined categories of Personnel, Equipment or Materials. This can include
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expenses, surcharges, premiums, allowances, or other additional fees that are related to the time
sheet.

If required, you can assign a line item to a person (for example, small tools allowance, or equipment
rentals, premium, or allowance), a piece of equipment (for example, repairs or additional charges),
material (for example, hauling charge), or entered as an Other line item.

Personne! | Equpment Material Lineltems ~Detals Diary Attachments

0.00 $0.00

The Line-ltem grid lets users:
¢ Allot a Custom Description to the item
e Charge it to a cost code (required)
e Attach it to an applicable PO#
e Assign a unit of measure
¢ Track the quantity
¢ Key the rate instantaneously

e Track the item against Project Commitments (See Assigning Commitments to Projects section of
this guide)

Right click any column header and select Column Chooser to view this list. You can then drag and drop
any of the additional fields into the time sheet view or remove any fields that are not required.

You can control where the new column will be displayed in the grid by dragging and dropping
the column headers in the desired location.
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21 Sort Ascending
Z1 Sort Descending
Clear All Sorting
l Group By This Column
4° Hide Group By Box
Hide This Column
=| Column Chooser
+a+ BestFit
Best Fit (all columns)
Y Filter Editor...
Show Find Panel
Show Auto Filter Row
Filter Mode >

My Column Caption

Right click on the column header that you wish to rename and select My Column Caption
option. If you wish to use the default name, blank out the custom name.

Once you have created a layout with the columns relevant for data entry, save the layout by selecting
the Layout drop-down from the top, right side of the tool bar. If this is a new layout, select Save As. If
you are saving changes to an existing layout, select Save.

1.36.0.3 Details tab

On the Details tab, you can capture any field notes associated with the time sheet, and enter data into
any custom timesheet fields set up by the application administrator.

Personel | Egupment = Material  Lineltems Detals Diary = Attachments
Notes Name

Exdude From Time Re-Allocation
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You can capture additional time sheet details on the Diary tab.

Personnel  Egupment  Material  Lineltems Detals Diary  Attachments

Did any of the Crew experience an injury today that was not reported? If so, please describe Safety Concers Conversations W/ Owner
Work Performed Visitors to Site
X-tra Work Performed Equipment Damage
Cost Impacts Other Observations
Schedule Impacts Incidents
Lessons Learned Injuries

Did any incidents occur today that need to be reported? If so, please describe.

Weather Conditions

What other information s relevant to support noted items from the Daily Diary Checklist?
Temperature

Upon completion of time sheet data entry, click Apply or OK at the bottom right of the page to save
your changes.

Park Close  Last Created T/S #: v |New T/S after Apply oK Cancel Apply

The Park and Close fields affect time sheets that need to be put on hold or closed.

Creating a time sheet layout

1. Right click any column header on one of the timesheet grids and select Column Chooser to view a
field list.

You can then drag and drop any of the additional fields into the time sheet view or remove any fields
that are not required.
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21 Sort Ascending
Z1 Sort Descending
Clear All Sorting
l Group By This Column
4° Hide Group By Box
Hide This Column
=| Column Chooser
+A+ Best Fit
Best Fit (all columns)
Y Filter Editor...
Show Find Panel
Show Auto Filter Row
Filter Mode >

My Column Caption

You can control where the new column will be displayed in the grid by dragging and dropping
the column headers in the desired location. You can also select My Column Caption to rename
the column headers.

2. You can control where the new column shows on the page by dragging and dropping the column
headers to the location.
You can also select My Column Caption to rename the column headers.

3. After you have created a layout with the columns relevant for data entry, you can save the layout by
selecting the Layout drop-down from the top right side of the ribbon bar.

4. Click Save As.

The Save Layout As dialog box opens, and you can name the layout.

This layout is specific only to the user logged into Billings. It will not be available to other users unless it
is shared by the user or an Administrator.

5. After the layout has been saved, the user can select Set Default which will be the default view when
they access the Timesheet page in the future.
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mg X

Layout Close

-

Save As...
System Default
Set Default

Remove Default

InEight Billings X

Save Layout As...

OK Cancel

When saving a layout, it is best practice to modify all the tabs (that is, Personnel, Equipment,
Material, and Line Items) that will be used in the specific layout being saved.

6. After the layout has been modified, click into the Personnel Name field on the page and either begin
typing the resource last name or use the drop-down list to pull up a list of personnel resources.
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When entering time sheets into Billings, it is time effective for you to use the Tab key to move
from column to column. When using the Tab key at the end of the last row, Billings
automatically creates a new row and jumps to the first column in the new row, copying values
from the last selected row.

To view the Timesheets tab and all time sheets that have been created, go to the menu list and expand
the Timesheets option, then select Timesheets.

1.37 COPYING AN EXISTING TIMESHEET

You can copy an existing time sheet by following these steps:

Copy existing timesheets

1. Go to Timesheets > Timesheets.

Timesheets

2. Select the time sheet to be copied by clicking it once. If the timesheet you are looking for is not in
the list, type in the time sheet number in the Timesheet # field to search for it. If you still cannot find
the timesheet in the initial list, you may need to click the “Refresh” button on the ribbon bar to
retrieve more matching timesheets from the database.
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HOME
- __________________________________________°]
l:‘xC:'rI a EZ‘ Xt @ Print Ej@ EX

New Delete Refresh Generate Viewlods Create Sundo & PrintPreview  SendTo  View: Al Layout  Close
~  Row(s) Line Items Template - - -
Actions Edit Print Save Filter e
Timesheets © g
0
Timesheet £ Type Timesheet ID Job# Root Project Neme Region Company Work Date Days Status v
T - e e e e e e - - # Closed .
0000019390 Single Day Timesheet 0000019390 DEMO KIEWIT DEMO(DEMO) Aberta Mining Company Jan-17-2023 1 Open
0000019389 Single Day Timesheet 0000019389 Kennedy QA Test Kennedy QA Test(Ken... | Aberta Techmation Electric & Cont 15-2023 1 Open
B Copy of 0000019386 | singe Day Timesheet | 0000019388 | | oevo | kEwrT DEMopEMO) | Aberta | Mining Company | 3an-14-2023 | 1| open

0000019386 Single Day Timesheet 0000019386 DEMO KIEWIT DEMO(DEMO)  Aberta Mining Company Jan-13-2023 1 Open

HOME
0]
SCF f B85 xwom [ o @ X

New Delete Refresh Generate Viewlods Create Sundo @ PrintPreview SendTo  View: Al Layout  Close
~  Row(s) Line Items Template  [3 - - -
Actions it Print Save Filter Win e
Timesheets © -
x |'searc Fod |
Timesheet # Type Timesheet ID b # Root Project Name Regon Company Work Date Days Status v
s = e o o e ol e - - # Closed

3. Click Copy from the ribbon bar.

4. Click Special Paste

Ensure Special Paste is selected and not Paste as Special Paste lets you control how the copy
process is performed.
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Paste Special (Copy of T/S# 0000019389) X

1. Choose the type of copy you wish to make:

e Copy (makes a new unlocked copy only);

Credit (makes a credit timesheet only)

Adjustment (make| Y)
: b Caredit (makes a credit timesheet only) i:p,

2. Enter timesheet details:
Credit T/S #:

New copy of Timesheet:

TS # Copy of 0000019389
T/S Date: Jan-15-2023 -
Copy the following values from the original:

v |Hours and Quantities
v | Line Items

v | Timesheet Notes
GPS Location

To remove from the newly created copy:

Inactive Employees
Inactive Equipments

Inactive Materials
3. Pressing OK will copy the timesheet and:

® Return you to the timesheet list Open the new timesheet

OK Cancel

5. In section 1, choose the type of copy you want to make.

6. Section 2 automatically names the time sheet as “Copy of”, plus the original timesheet number.
Change this to the new time sheet number if needed. Select the work date for the new timesheet. This
section also contains the options of having the hours, quantities, line items, and time sheet notes pull
in from the original timesheet it was copied from.

7. In section 3, select Open the new time sheet.

8. Click OK. The new time sheet opens. You can modify the time sheet as required with any
information that needs to be changed.

1.38 IMPORTING A TIMESHEET

Billings lets you import multi-project or multi-day time sheets from a spreadsheet if the correct
template is used.
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Import a time sheet

1. Processes > Imports > Timesheet Import.

Actuals Task Transfer Adjustment

Retro Rate Adjustment

Rate Table Import

Timesheet Import

Legacy Labour Rate Imports

oo Process Status

g
T

E Job Schedule

The time sheet Import window opens.
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HOME (m]

B =C m X

Create Delete Refresh Layout  Close
Import Row(s) -

Timesheet Import ©

I:(j Using imports allows you to import a file from other applications into DTC.

Created Desaription Create By Status
= o e e

T [ [ R

Completed

Completed
Completed

Record 10f 4

2. Click the Create Import button. The Import Definition dialog box opens, and you can specify the file
containing the timesheet data that you want to import. Billings previews the file contents in the time
sheet Header, Personnel, and Line Items tabs.
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[§ Import Definition m] X

e Name: Timesheet Import

Enter Criteria:
Import Timesheet Source Excel File: C:\Users\Crystal.Gerstel\Desktop\Time

Submit OK Cancel Apply

3. You can edit the data in the import window in Billings to correct any errors that are reported. After
you have corrected the errors, click OK to revalidate the data. This lets you correct errors in the import
file without having to edit the file itself.

1.39 LEMS

1.40 CREATING A LEM

The standard Billings LEM process is called LEMs, which stands for labor, equipment and material
reports. When selecting a project via the Project tab and managing the criteria, the criteria screen has
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two tabs, General and Project. Both need to be populated.

Create a LEM

1. Go to LEMs > LEMs.

The LEMs tab opens, listing all results previously generated LEMs.

B =C o~ B X

Creste Delete Refresh 3 Print Preview Layout Close
Process  Row(s) >

LEMs ©
_> Using exports allows you to save system data as a file. This file can then be imported into other applications to remove the need to double enter data and reduce entry errors
e
Created Document & Description Project Code Project Hame Sequence Number Batch ID Date Range Created By Status
ofc o o) o o ol N

LEM#111111.500 - LEM exmaple 1 111111.500 “LEM Demo 21 458 2024-06-21 - 2024-0.
EM #111111.500 LEM Demo S 0

Sample | 111111.500

0 Sample 111111.500 20
111111.500 19

1111115002 3

111111500 18

111111.500 17

111111.500 17

111111.500 16

1111115002 2

Sample Third Party 111111.500 15
111111.500 14

111111 500

Record 10f 22

2. To review the contents of a particular LEM, or for LEMs that require approvals, select the applicable
result, and then double-click to open the LEM in its own LEMs Detail tab.
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Depending on the process type, the Notes section can contain information regarding the
outcome of the process. The contents of the resulting Details page varies by each process type.

3. If the LEM has not yet been approved, you can review the detailed results and remove any lines that
should not be approved. After reviewing results, you can then approve the LEM, which in turn locks the
underlying data from future edits.

LEMs LEMs Detail ©
D) This B coved setthe ed an Accepte fotesi
vl ng a approvedis a ad will make read-orly = exportas approved
c
Description:  LEM  DEMO - DEMO4 (23695)
Created: 5/18/2022 2:55 PM Status: Pending Approval
Datt )
Modified: 5/18/2022 2:56 PM Date Accepted: - Ve DEMO4
Froject 0 (0EMO)
Detail Attachments
TSD | Proj. Pro.. Frop. Proj. | Proj. Wes. Wor. T/S® so.. Reso..| Reso..| Type |Reso..| shift | Cust.| Cust. BilA. |BIA. Cost. Cost. Lme. Lne. | WeS. Cost. UOM |Qy  Mark. Mark. BIR. BllA. | T/SL
= m3% pEMO KE osfo... oem Ao Wt %0-. 2062 J72. 0  EA 1000 100. 8. 8. 405
1833 | DEMO | K2 osfo... | oem pe mate 7 EAL | 1000 100. 158.. 1%.. 174
18338 DEMO KIE 05/0. DEM. Ape. Mate EAL 1.000 10.0. 8.241 824 90.6.
18333 DEMO KIE 05/0. DEM. \pe Mate. EAL 1.000 10.0. 2. 287. 316.
18333 DEMO KIE 05/0. DEM. \pe Mate. FT 2.000 10.0. 1] 83.0. 193,
18338 DEMO  KIE 05/0. DEM. Ape. Mate. FT 0. 83.0. 9.680
18338 DEMO  KIE 05/0. DEM. Allia. Mate. EAL 105. 116,
18338 DEMO  KIE 05/0. DEM. Allia. Mate. EAL 3.156 315 34.7.
18338 | DEMO | KEE osfo.. | oem Ala. | vate A B2, 211
18338 DEMO  KIE... 05/0. DEM.. Willy"... | Tran... Ls 5.3, 75.3.
18338 DEMO  KIE... 05/0. DEM.. Ape. Mate. EAL 94.2. 103.
18338 DEMO  KIE... 05/0. DEM.. Ape. Mate EAL .| 25.0. 27.5.
18338 | DEMO | K2 osfo...| oem . oo | A 6.1 L. s
1833 | DEMO | Kz osfo.. | oM. | 1839 | RO | Lnel oo e EAL | 1000 100. 134 134 14
1833 | DEMO | Kz osfo.. | oM. | 1839 | RO | Lnel oo e EAL | 1000 100. 134 134 14
18338 DEMO KIE 05/0. DEM. 18338 | 3RD Linel Allia. Mate EAL 1.000 10.0. 12, 12 135.
18333 DEMO KIE 05/0. DEM. 18338 | 3RD Linel. Russ. Mate. FT 20.0. 10.0 11.0. 5.500 121
18333 DEMO KIE 05/0. DEM. 18338 | 3RD Linel. Ape. Mate. EAL 1.000 10.0. 5; 5. 41
18338 DEMO  KIE 05/0. DEM. 18338 | 3RD Linel. Ape. Mate. EAL 1.000 10.0. 1.99¢ 199 218,

Record 10f 38

oK Cancel Apply

4. You can create a layout for the LEMs Detail page by selecting the Layout drop-down list on the right
side of the ribbon bar.

5. Depending on the process, you can send the process results to a report or send the data to a file
using the export-specific buttons at the bottom of the page. See the Report Export Options topic for
more details on viewing the export details as a report.
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oG X

Layout Close

-

Save As...

System Default e e W

Set Default
Save Layout As...
Remove Default |

OK Cancel

6. After you have reviewed or approved the export, click OK or Apply to save your changes and exit the
page. If you want to cancel your changes, click Cancel.

7. To initiate a new instance of a LEM, select the Create Process icon located on the ribbon bar.

LEMs LEMs Criteria ©

Enter Filter Criteria:

8 The LEMs Criteria screen opens with the General tab selected. This tab lets you set the LEM
parameters that control the scope of the data that will be processed by the LEM process.

9. Use the Project tab to specify a specific job, or specify individually selected WBS items for a single
job to limit the scope of the data processed by using the Limit Scope To section of the screen.

10. Click the Submit icon located on the ribbon bar when you are done setting the parameters and
want to initiate the LEM process.
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= [ Copy —
|_:| Py Kot -— ><
v —
[ Paste
Submit Sundo  Criteria Close

To check on the progress of your request, go to the Process Status page (Processes > Process Status).

To see your new request listed on the LEMs tab, click the Refresh icon located on the ribbon menu. You
can also filter by project code to quickly find LEMs tied to a specific project.

1.41 LEM DETAILS

You can view the LEM details by double-clicking to open the LEM from the LEM register.

The LEM details page includes the document number, the date it was created, the last modified date,
the description, status, and the date accepted. You can also view any notes and criteria linked to the
LEM. If there are any related files, you can find the detail attachments in the attachments tab.

InEight Billings - =] X
HOME BILLINGS DEMO (PTR2) [
Copy -
C ®= xu sm I3 m X
[§ Paste
Refresh = Undo & Print Preview GidTo Bxport Layout Close
To .

LEMs LEMs Detail ©

| This export has been approved and can no longer be edited. To save another copy of this expon, use the Export button
Document #: LEM # 111111.500 - LIUD0021 (312 Description: LEM exmaple 1

reste Stat

Mod Date Acc

A 1: Fal
Deta Atachments ~ Attachment Manager
Project Code Project Pay Pay kem Description ~ Pay ltem & ( Project D Project Dim 2
134 111111.500 ‘LEM 3 Pay kem Example 3 3 I
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Description

The Description field lets you add context or explanations for individual LEM entries. When you view
the LEM register, this information appears in the descriptions column, making it easy to see what each
LEM is about at a glance. Use this field to include any quick notes or details that help you understand
the purpose or scope of the LEM without having to open it.

Date Range

The value displayed is based on the first date and last date of records that were collected into the LEM.
For example, If the criteria used was September 1-30, 2025, but the first records is for September 6,
and the last record is for September 29, then the Date Range displays 2025-09-06 — 2025-09-29.

1.42 INVOICES

1.43 CREATING AN INVOICE

An invoice records the transaction between a buyer and seller, and establishes the terms of payment.

Create an Invoice

1. Go to Invoices > Invoices.

The Invoices tab opens with a list of all previously generated invoices.

OME
= C &m = X
Create Delete Refresh @ PrintPreview Layout  Close
Process  Row(s) -
Invoices ©
D) Using exports allows you to save system data as a fle. This file can then be imported into other appiications to remove the need to double enter data and reduce entry errors
jel
Created Desaription Created By Status
ar ol o -
NETyeT 0000000109

2. To review the results of a particular invoice process, or for invoices that require approvals, select the
applicable result, and then double-click to open the invoice process in its own Invoices Details tab.
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Invoices Invoices Detail © -
Ij) This Export has not yet been approved. To mark it as approved, set the Status to Approved and fillin the export's Date Accepted ot
value. Marking an export as approved is a permanent action and wil make this record read-only. Marking an export as approved
cannot be undane.
Description:  DEMO - DEMO1 (23703)
: Criteria:
Created: 5/18/2022 3:21PM Status: Pending Approval - Override Invoice Num: DEMO1 B
Date From: May-01-2022
Modified:  5/18/2022 3:21PM Date Accepted: - Date To: May-18-2022
Invoice Date: May-18-2022 v
Detail | Attachments
T/SID  Project... Project.. Project.. Project.. Project.. WBSLL. T/Sob.. Resour.. Resour. Resour.. Type  Resour.. Linelte.. Custom. BlASC.. BlAsN.. CostAs.. CostAs. WBSPa.. UOM Qty Markup.. Markup.. BilRate Bl Amo.. GeneratedL
= 18334 DEMO  KIEWI. PROGR.. labour 150597 Ewing,.. Subcon.. DSPCo Welder .. KCWD.. KCW.. KCWD.. Welder.. 26722.. ST 8.000 54990  439.920 B
18334 DEMO | KIEWIT PROGR... Labour | 119926  Cooper.. Subcon.. DSPCo. Labour.. | KCABR | KCla.. KCABEL Labour.. 2672\2.. OT 5.000 45.070  225.350
18335 DEMO | KIEWIT PROGR.. Labour | 111295  Hedn,.. Subcon.. DSPCo. Carpen.. KCCP1  KCCa. KCCP1  Carpen. 26722. ST 10.000 33.430  334.300
18333 | DEMO | KIEWIT. PROGR... Labour | 180681  Gerace.. Subcon.. DSP Co. Welder .. | KC-WD... | KC_W.. KC-WDBP Welder.. 2672\2.. DT 10.000 120000 1,200.
18335 DEMO | KIEWIT. PROGR... Labour | 69590  Calend.. Subcon.. DSPCo. Carpen.. KC-CP3  KCCa.. KCCP3  Carpen.. 26722 OT 2.000 83.000  176.000
18335 | DEMO | KIEWIT PROGR.. Labour 69590  Callend.. Subcon.. DSPCo Carpen.. KC-CP3  KCCa. KCCP3  Campen. 26722. OT 2.000 59730 119.460
18334 DEMO | KIEWIT PROGR.. Labour | 106145  Stefik.. Employee Kiewit - Labour.. KCABSR |~ KCLla. KCABSR Labour.. 26722.. ST 10.000 54210 542.100
18335 DEMO | KIEWIT PROGR.. Labour | 135545  Vienne.. Subcon.. DSPCo. Carpen.. KC-CP1  KCCa.. KCCP1  Carpen. 26722. ST 5.000 33430 167.150
18335 | DEMO | KIEWIT PROGR.. Labour 129630  Lakhan. Subcon.. DSPCo Carpen.. KC-CP4  KCCa. KCCP4  Carpen. 26722.. ST 10.000 49.600  496.000
18335 DEMO | KIEWIT PROGR... Labour | 117891  Middet.. Subcon.. DSP Co. Carpen.. KC-CP2  KC Ca. KCCP2  Carpen.. 26722.. OT 2.000 52400 104.800
18334 DEMO | KIEWIT PROGR... Labour | 50320  HolmM.. Subcon.. DSPCo. Superin.. KC-SUP  KCSu. KCSUP  General.. 26722. OT 10.000 125670 1,25.
18334 DEMO | KIEWIT PROGR... Labour | 150597  Ewing,..  Subcon.. DSP Co. Welder .. | KC-WD... | KC_W.. KCWD.. Welder.. 2672\2.. OT 2.000 74.3%0
18335 DEMO | KIEWIT PROGR... Labour | 135545  Vienne.. ' Subcon.. DSP Co. Carpen.. KCCP1  KCCa. KCCP1  Carpen.. 26722.. ST 5.000 33.430  167.150
18335 DEMO | KIEWIT PROGR.. Labour 69590  Callend.. Subcon.. DSPCo. Carpen.. KC-CP3  KCCa.. KCCP3  Carpen. 26722. ST 8.000 44.210  353.680
18335 | DEMO | KIEWIT PROGR.. Labour | 117891  Middet.. Subcon.. DSPCo. Carpen.. KCCP2  KCCa. KCCP2  Carpen.. 26722.. ST 10.000 38820 388.200
18334 DEMO | KIEWIT PROGR... Labour | 119926  Cooper.. Subcon.. DSPCo Labour.. | KCABR | KC_la.. KCABEL | Labour 2. ST 5.000 33430 167.150
18335 DEMO | KIEWIT PROGR.. Equpm.. 55429  Welder .. Owned  Kewit- Weldn.. | KCWD.. KC_W.. KC-WD... Welder HR 10.000 15,000 150.000
18335 | DEMO | KIEWIT PROGR... |Equpm.. S5721  Welder .. Owned  Kewit- Weldn... | K KC_W Welder HR 10.000 13.000  130.000
18340 DEMO | KIEWIT EQPAD... Equpm.. 54887  Welder.. Owned  Kiewit- Weldin... | KCWD.. KC_W.. KC-WD... Welder HR -10.000 15.000 | -150.000 .

183.000 10.000  4.000 31,803.. 42,834...
Record 10f 48

oK Cancel Apply

3. If the invoice has not been approved, you can review the results on the page and remove any lines
that should not be approved. After the results have been reviewed, you can then approve the invoice,
which in turn locks the underlying data from future edits. After you have reviewed or approved the
export, click OK or Apply to save your changes and exit the page. If you want to cancel your changes,
click Cancel.

Create a new Invoice

1. To initiate a request to generate one or more invoices, click the Create Process icon located on the
ribbon menu

HOME
0]
= C & Print E ><

Create Delete Refiesh (3 printPreview Layout  Close
Process Row(s) -

The Invoices Criteria tab opens with the General tab selected. This tab lets you set the invoice
parameters that control the scope of data that will be processed by the invoice process.
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General * | Project Process

Enter Filter Criteria:

2. Use the Project tab to limit the process scope to one or more jobs; if only one job selected, you can
use the Limit Scope To section to further the generation of the invoice(s) to specific WBS or Pay Items

3. Use the Process tab to limit scope of the invoice generation to only specific LEMs (for example, only
Approved but un-invoiced LEMs to be included)

4. Click the Submit icon located on the ribbon menu when you are done setting the parameters and
want to initiate the invoice process.

5. To check on the progress of your request, use the Process Status page (Processes > Process Status).

To view your new request on the Invoices tab, click the Refresh icon located on the ribbon menu.

1.44 MANAGING MASS CHANGES

1.45 RETRO RATE ADJUSTMENT

Billings lets you reverse locked timesheets to process various adjustments, such as retroactive rate
changes. The adjustment process generates locked credit time sheets that back out the previously
locked time sheet information and create new timesheets with refreshed rates. The new timesheets let
you to perform further edits before using the newly generated timesheets for LEMs, invoices or other
system processes (exports).

Start a Retro Rate Adjustment

1. Select Processes > Adjustments > Retro Rate Adjustment or Actuals Task Transfer Adjustment.
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e
ré Timesheets

Templates

Actuals Task Transfer Adjustment

Retro Rate Adjustment

The appropriate Adjustment tab appears for the adjustment process selected.

Billings User Guide

B =C

Create  Delete Refresh
Adjustment  Row(s)

Retro Rate Adjustment O

,_\p Using adjustment processes allows you to system generate credit and adjustment LEM entries for timesheet entries that have aiready been locked.
Created Desaription
e L3

= | 2023-0104 21:00:29

2023-01-03 14:32:01
202209221

2022:09221
202209
2022-09-22 10:07:05
2022-09-22 10:05:35
2022:09-22
2022:09
2022-09-2208:54:16

05

03:20

2022:09-22 08:52:45
2022-09-22 08:49:02
2022-05-18 15:04:40
2022-05-18 12:14:53
2021-12-09 12:15:46
2020-03-0707:59:47
2020-02-1108:07:54

Retro Rate (84375)
Retro Rate (84374)
Retro Rate (84373)
RetroRate (¢

RetroRate (¢
RetroRate (¢

Retro Rate (843
Retro Rate DEMO MU AD) (23699)
Retro Rate DEMO (23630)

Retro Rate (23652)

Retro Rate (15091)

Retro Rate (14229)

2. Select the Create Adjustment icon.
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Created By Status
e -
Kennedy Roulston Completed
administrator Completed
administrator Completed
administrator Completed
administrator Completed
administrator Completed
administrator Completed
administrator Completed
administrator Completed
administrator Completed
administrator Completed
Completed
Completed
Crystal Gerstel Completed
Crystal Gerstel Completed
Crystal Gerstel Completed

m X

Layout  Close
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1.45 Retro Rate Adjustment

) =C

Create  Delete Refresh
Adjustment Row(s)

m& X

Layout Close

The adjustment selection criteria dialog box opens. This dialog lets you set the filtering and adjustment
specific parameters which will control the scope of the data selected for adjustment and any output

formatting of data by the adjustment process. The filtering parameters and control parameters are

unique to each adjustment process type.

B =C

Create  Delete Refresh
Adjustment  Row(s)

Retro Rate Adjustment  ©

mEm X

Layout  Close

:ﬂ Using adjustment processes allows you to system generate credit and adjustment LEM entries for timesheet entries that have aready been locked.
Created Desaiption Created By Status
e o0 =
et Rate_TEST WORK ORDER (34410 loysalGena ________________________Jowew |

RetroR: 7)

RetroRate (¢
RetroRate (¢

2020-03-0707:59:47

RetroRate (:

2020-02-1108:07:54 Retro Rate (14229)

Kennedy Roulston Completed
Completed

Completed

Completed
administrator Completed
administrator Completed

administrator Completed

administrator

Completed
Completed
Completed
Completed
Completed
Completed
Completed
Crystal Gerstel Completed

Crystal Gerstel Completed

3. Click the Submit icon located on the ribbon bar when you are done setting the parameters to initiate

the adjustment. A dialog box opens indicating the process was submitted.
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InEight Billings X

” Process has been submitted. Please use the Refresh button to check the result after the process done.

LK

4. To check on the progress of your request, use the Process Status screen (Processes - Process Status).

To see your new request on the Retro Rate Adjustment tab, click the Refresh icon located on the
ribbon bar.

1.46 GENERATE TIMESHEET LINE ITEMS
WIZARD

It might be necessary to generate multiple time sheet line items based on a set of project rules. The
Timesheet Line-Iltem Generator lets you create a time sheet with line items that are based on results of
calculations based on entered set of criteria.

Generate time sheet line items

1. From the Timesheets page, click the Generate Line Items icon on the ribbon bar. The Generate Line
Iltems wizard opens.

HOME
0
= O fI ﬂ @ (3 Copy X ot @ Print D) @ E X

New Delete Refresh Generate Viewlocks Create ©OuUndo @ PrintPreview SendTo  View: Al Layout Close
*  Row(s) Line Items Template - - -

2. Click Next to continue.
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Timesheets Generate Timesheet Line Items  ©

Generate Timesheet Line Items

te a timesheet which wil

To continue, dick Next

Next > Cancel

3. Select the type of calculation logic you need to use for the line item generation and click Next. Select
one of the following options.

Timesheets Generate Timesheet Line Items  ©

Line ltem Parameters
Spedify the type of calaulation to use

‘The line items are generated based on a set of calculation rules. You must specify which set
of rules you wish to use to generate these line items:

o et amount per hour worked
Set amount per hour worked by type of time (ST, OT, DT, DTH, TT, LOA)
Set daily amount if hours worked for that day exceed set threshold

Set daily or weekly amount based on daily and weekly minimum hours rules.

<Back [ Next> || | Cancel

» Set the amount per hour worked — Calculates amount by multiplying total labor hours within a
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specified time by a preset hourly amount.

Timesheets Generate Timesheet Line Items O

Line ltem Parameters
Spedify calculation detais

Cancel

e Set amount per hour worked by type of time — Calculates the amount by multiplying various Labor
hour totals grouped by unit of measure by a preset hourly amount set per type of time. Type of time
refers to the Labor unit of measure (i.e., ST, OT, DT, etc.).
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Timesheets Generate Timesheet Line Items O

e Set the daily amount if hours worked for that day exceed set threshold — Calculates a daily amount if
the total Labor hours for that day meet or exceed a preset threshold.

Timesheets Generate Timesheet Line Items O

id calcuiation type will generate a e item for the amount specified below for each day that an
o exceeded the threshold number of work hours.

4. Set daily or weekly amount based on daily and weekly minimum hours rules — calculates amounts
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based on day of week threshold hours rules. If Labor hours meet or exceed all daily thresholds then the
weekly amount applies, otherwise daily amounts are calculated for all days that meet or exceed the
daily thresholds. For days that do not meet the daily threshold, hourly amount applies.

For this calculation type, the date range is specified with a starting date and an indicator as to
how many full weeks of data to use as source for the calculations.

Timesheets Generate Timesheet Line Items O

Line ltem Parameters

5. Click Next to begin specifying the time sheet criteria to base the calculations on. The criteria include
project(s), time sheet and time sheet Approval Status, and time sheet Work Date range. After you have

specified the filters click Next.
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Timesheets Generate Timesheet Line Items  ©

Line ltem Parameters
Spedify source data for calculation

Projects
Please select the project or projects for which the line items should be generated.
v <Alprojects>
*SAMPLE BUDGET PROJECT (190013) - 15-30 Separation Fadiity - Field Construction(190013)
“SAMPLE PROJECT (180002) - Pipestone Liquids Hub, Fadiity Construction(180002)
*SAMPLE PROJECT (190010) - AWTF Electrical Construction(190010-K104)
“SAMPLE PROJECT (190010) - AWTF Pipeline(190010-110)
“SAMPLE RETRO-RATE AD] PROJECT(180004)
“SAMPLE TASK TRANSFER PROJECT (190012) - 15-30 Separation Fadiity Fabrication & Assembly(130012)
*SAMPLE WO PROJECT (190010) - AWTF General Construction(190010K103)
[INTERNAL] Estimating - 2020(200000)
BL Project Name(BL Project Code)
Import Root Project(IMPRC2)
Import Root Project(IMPRC2_CSV)
Kennedy QA Test(Kennedy QA Test)
KIEWIT DEMO(DEMO)
QA test 2(QA test 2)
QA test(QA test)
SAMPLE PROJECT - 14-30-071-08 W6M Compressor Plant(180011)
SAMPLE PROJECT - E~406 Stainless Valve Replacement(200005)
SAMPLE PROJECT - Fabrication & Assembly(180015)
SAMPLE PROJECT - Field Pipe Fabrication(200006)
SAMPLE PROJECT - Shop Fabricated Pipe & Fittings(190008)
SAMPLE PROJECT - Stainless Steel Spools(200002)
SAMPLE PROJECT - Tower Stabilzer Feed Bottom Exchanger (200001)
TEMP(TEMP)

Timesheets
Indude timesheets that are: |/ | All Tmesheets, or: | | Approved Locked Pending

T 3302023 +| to [Jan31023 -

6. Select personnel filters, if any, and click Next.

Only projects with assigned personnel will let you filter by person.

InEight Inc. | Release 25.9

<Back

Next> | Cancel

Page 147 of 154



1.46 Generate Timesheet Line ltems Wizard Billings User Guide

Timesheets Generate Timesheet Line Items O

Line ltem Parameters
Select Personne

Select "All Personnel", or spedify individuals for whom the line items should be generated. By default, line items wil be generated for all indviduals.

Note: If any of the selected projects do not require pre-assignment of personnel, all personnel for those projects wil be induded in the calaulation,

Name

7. The generated line items will attach to a newly created time sheet. In this step, provide details about
the time sheet header as well as the generated time sheet Line Items, and click Next.

The Roll up calculated values to a single line-item option lets you summarize all generated line
items to a single line item on the generated time sheet. This is a single line item that will not be
associated with any personnel records.
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Timesheets © Generate Timesheet Line Items O

Line ltem Parameters
Spedify generated timesheet details

generated on a new timesheet. Please supply values for the various detais of the generated

8. Review your criteria and click Next.
The criteria preview content will copy to the Notes field of the generated time sheet.

9. The final step of the wizard displays the calculation results. Clicking the Finish button will open the
Timesheet page with the generated time sheet.

The generated time sheet is not actually created in the database, and you will need to
click Ok or Apply on the time sheet page to save it to the Billings database.

1.47 VIEWING TIMESHEET LOCKS

Timesheets can be locked by multiple processes in the system. The ability to understand which
processes have locked a specific time sheet record is often helpful in troubleshooting a solution to fix a
record that has been incorrectly captured. For example, if a time sheet record has been locked by a
LEM process, but the LEM has not been issued to the client, then deleting the LEM process with that
time sheet record on it lets you modify the record, as it becomes unlocked after the process has been
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deleted. However, if one or multiple processes have locked a record, and they cannot be deleted, then
any adjustments must be handled through an adjusting process.

View time sheet locks

1. Go to Timesheets > Timesheet.

2. From the Timesheets tab, select the time sheets you want to view, and then select the View Locks
icon located on the ribbon bar.

-
[y = (@) Copy. =
= ( + a = | 2 Xcut @ prnt ® (| X
New Delte Reffesh Generate Viewlods Create Sundo & PrintPrevien SendTo  View: Al Layout  Close
< Row(s) Line Items Template [ d - - -
Actions Edit Print Save Filter Window

©  Timesheet - Single -
Timesheet = T Type Timesheet ID Job # Root Project Name Region Company Work Date Days Status Y
T e = e 3 # Closed

0c 0c 0 0c - - -

e S N S = S = S =N
T [ S S I = e = e v e R =S
[covommms gt Jowe | o |womoonoom [men  [wmomy  [msmn | ilom |
e [ S U S N - N T S T~ R ™ N S
R - S L S N LT S LT G = R e R N N

0000019384 Single Day Tmesheet 0000019384 180002 *SAMPLE PROJECT (1. Aberta Ovintiv Canada ULC Jan-11-2023 1 Open
0000019383 Single Day Tmesheet 0000019383 180002 *SAMPLE PROJECT (1. | Aberta Ovintiv Canada ULC Jan-10-2023 1| Open

3. A new tab opens listing the selected timesheet with the following columns available for cross
referencing:

e T/SID

o T/SH

e T/S Start Date
e T/SType

e Approval Status
e T/S Status

e Parked

4. From the T/S ID column, click the plus (+) icon to view the selected timesheet results. The T/S Items
tab opens with a list of all timesheet records within the timesheet selected.
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I —- T
Layout Close

C va X cut

Refresh  Undo

Actions Edit
Timesheets Timesheet - Single Day: 0000019389 Timesheet Cross Reference © -
T T/SStartDate /S Type Approval Status T/5 Status. Parked

5D TS
T e = 0000019385 #0c o e e e
monsws N I N R

= [+ 0000019385

Edit Fiter

Record 10f 1

x v| | T/S# = 0000019385

5. Double-click the timesheet item you want to view to see which processes have locked or consumed

that timesheet item.
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Timesheet - Sing| ©  Timesheet Cross Reference

Project: BL Project Code (BL Project Name) /S ID: 0000019385 Ordered By:

Regon: Aberta ~ | Company SemCAMS ULC T # 0000019385 Location Biled To;

Division: Field Construction Job # Client #:

Date: Jan-11-2023  ~ T/S Totak: $816.30

Persomel | Equipment = Material  Lineltems = Detais Diary Attachments

Unit 2 Personnel Name Personnel Code  Bil As Cost As shift Cost Code st LoA Day

e ) -

1.48 REPORTS

1.49 REPORT EXPORT OPTIONS

Click the Send To menu option located on the ribbon bar at the top of the page, and then select either
Grid or Pivot Grid. Depending on which report is opened, the Excel option can only be used when the
report has first been exported to a grid or pivot grid.

If Grid is selected, the report data is pushed to a spreadsheet-like grid that lets you group, filter and
sort the data and create basic mathematical group functions like summing, counting, averaging, etc.

Grouping is done by dragging a column header to the grey box located at the top of the window.
Sorting is done by clicking on a column header. The first click sorts the data in ascending order, and the
second click reverses the order.

You can use the first row of the data to apply filters to the data shown within the grid. Alternatively,
you can use the quick filter, by clicking on the small funnel icon located on the right hand side of every
column. This will show you a selectable list of values to filter.
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All other functions are accessed through the Customization menu by right clicking on a column to bring
up the Customization dialog box.

As with all other Billings grids, you can create and save custom layouts for the grid and pivot grid
reporting views. After a layout has been created with the relevant columns, you can save the layout by
selecting Layout from the top, right side of the tool bar.

Filters and sort order is also saved with the layout.

If Pivot Grid is selected, there are five view options to select from and more than one of these options
can be selected at the same time.

Show Column Grand Totals Show Column Totals

Show Custom Totals for Single Values Show Grand Totals for Single Values
Show Row Grand Totals Show Row Totals

Show Totals for Single Values

As with the Grid report, the data is displayed in a spreadsheet pivot- style, and it can be manipulated
by dragging and dropping the columns around the page. You can customize the results by applying
filters to headers, add or remove displayed columns using the customization pop-up menu, rename
columns and saving layouts with these changes.

If Excel is selected, an Export to Microsoft Excel Document dialog box opens. Choose the destination
the file should save to, and then click Save.

When the file is opened, you can edit or adjust the report as required through the Excel spreadsheet.

Click the Close button to exit any of these reports. This will return you to the Report List grid.

1.49.0.1 Print Preview

Click the Print Preview icon located on the ribbon bar. If only one report is assigned to the process you
are reviewing, the report will open by default. If there are multiple report options, a window will open
listing all available reports. You can then double click on the desired report to open.
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C & Print D E ><

Refresh @ printpreview  SendTo Layout Close

Print Preview

= |—2| D I:ID — » 00
= = | D\j D & & Er € € > pl g GO Q Q &« ¢
Print  Quick Options Header/Footer Scale Margins Orientation  Size Find  Thumbnais Next Last Many Pages ZoomOut Zoom ZoomIn Page Color Watermark Export Close
Print - - - - Page Page @& - - -
Reports Reports - Print Preview © -

Report Name
|Activity Report
\Attendance - LEM Discrepandes
\Attendance Grid Reportt
\Attendance Roster
Blank TS
Classification Audt
Classification List
Commitment Summary
DTC-Copy of Activity Report
DTC- Copy of Job Summary
Daily CrewTimesheet

Daily LEM

Detailed Payroll Entry Report

Equipment Audt

Equipment List

Incurred Commitments

InvoiceReportt

130b Summary

Labour Equipment Materia
Material List

NextDay Timesheet

Payroll Audit Report (Multi Unit Columns)
Payroll Audit Report (unit and quantity)
Payroll Entry Report

Personnel Audt

Personnel List
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